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Overview

e Chapters 2 to 4 describe how to call APIs in different authentication modes.
e Chapters 5 to 6 describe how to call APIs using a custom authorizer.

e Chapter 7 provides guidance to API providers on how to create backend
signatures to ensure secure access to backend services.

e Chapter 8 provides guidance to API providers on how to import APIs from
Swagger files to APl Gateway, and also provides guidance for API providers
and callers on how to export APIs from API Gateway.
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Authentication Mode Selection

API Providers

API Callers

The following authentication methods are available for calling APIs:

e App authentication (recommended)

API callers will be authenticated using the AppKey and AppSecret issued by
API Gateway.

a. App authentication is oriented to the tenants of APl Gateway.
e |AM authentication
Token and AK/SK authentication is supported.

-  Token authentication: Requests are authenticated using a token. This
authentication mode is recommended because it requires no SDK
signatures.

- AK/SK authentication: Requests are signed using an AK and SK in the
same way as in App authentication mode.

IAM authentication is oriented to the tenants of APl Gateway.
e Custom authentication

You can compile a function in FunctionGraph and use it for authentication.
For details about API calling, see Creating a Function for Frontend Custom
Authentication.

e None

APIs with None authentication require no authentication of users accessing
these APIs.

a. lItis intended for all public network users.

1. If you obtain an API from an offline channel, contact the API provider to
confirm the authentication mode, and then call the APl according to the
instructions in this document.
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Calling APIs Through App
Authentication

Preparation
App Authentication
Java

Go

Python

C#
JavaScript
PHP

C++

C

Android

curl

3.1 Preparation

Before calling APIs in App authentication mode, complete the following
operations:
e  Obtain the domain name, request URL, and request method of the API.

View the settings by choosing API Call > API Request on the API details page.
e  Publish the API in an environment before you can access it.

View the environment in which the API is published on the APl Request page.

e  Provide a valid AppKey and AppSecret to generate an authentication
signature.
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Create an app on the Apps page and bind it to the API. Then you can use the
AppKey and AppSecert of the app to access the API. View the AppKey and
AppSecret on the app details page.

(11 NOTE

e AppKey: access key ID of the app. It is the unique ID associated with a secret access
key. The AppKey and AppSecret are together used to obtain an encrypted signature
for a request.

e AppSecret: secret access key used together with an AppKey to sign requests. The
AppKey and AppSecret can be together used to identify a request sender to
prevent the request from being modified.

e When sending an API request, add the current time to the X-Sdk-Date header
and the signature information to the Authorization header.

/A\ CAUTION

The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

AP| Gateway checks the time format and compares the time with the time
when API Gateway receives the request. If the time difference exceeds 15
minutes, APl Gateway will reject the request.

3.2 App Authentication

1. Construct a standard request.

Assemble the request content according to the rules of APl Gateway (API
Management), ensuring that the client signature is consistent with that in the
backend request.

2. Create a to-be-signed string using the standard request and other related
information.

3. Calculate a signature using the AK/SK and to-be-signed string.

Add the generated signature to an HTTP request as a header or query
parameter.

5. After receiving the request, APl Gateway performs 1 to 3 to calculate a
signature.

6. The new signature is compared with the signature generated in 3. If they are
consistent, the request is processed; otherwise, the request is rejected.

(11 NOTE

The body of a signing request in app authentication mode cannot exceed 12 MB.

Step 1: Constructing a Standard Request

To access an APl through app authentication, standardize the request content, and
then sign the request. The client must follow the same request specifications as
APl Gateway so that each HTTP request can obtain the same signing result from
the frontend and backend to complete identity authentication.
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The pseudocode of standard HTTP requests is as follows:

CanonicalRequest =

HTTPRequestMethod + "\n' +
CanonicalURI + '\n' +
CanonicalQueryString + '\n' +
CanonicalHeaders + '\n' +
SignedHeaders + '\n' +
HexEncode(Hash(RequestPayload))

The following example shows how to construct a standard request.

Original request:

GET https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?b=2&a=1 HTTP/1.1
Host: c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
X-Sdk-Date: 20191111T093443Z

1.

Specify an HTTP request method (HTTPRequestMethod) and end with a
carriage return line feed (CRLF).

For example:
GET

Add a standard URI (CanonicalURI) and end with a CRLF.

Description

Path of the requested resource, which is the URI code of the absolute path.
Format

According to RFC 3986, each part of a standard URI except the redundant and
relative paths must be URI-encoded. If a URI does not end with a slash (/),
add a slash at its end.

Example

For the URI /app1, the standard URI code is as follows:

GET
/app1/

(10 NOTE

During signature calculation, the URI must end with a slash (/). When a request is
sent, the URI does not need to end with a slash (/).

Add a standard query string (CanonicalQueryString) and end with a CRLF.
Description

Query parameters. If no query parameters are configured, the query string is
an empty string.

Format

Standard query strings must meet the following requirements:

- Perform URI encoding on each parameter and value according to the
following rules:

® Do not perform URI encoding on any non-reserved characters
defined in RFC 3986, including A-Z, a-z, 0-9, hyphen (-), underscore
(L), period (.), and tilde (~).

" Use %XY to perform percent encoding on all non-reserved
characters. X and Y indicate hexadecimal characters (0-9 and A-F).
For example, the space character must be encoded as %20, and an
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extended UTF-8 character must be encoded in the "%XY%ZA%BC"
format.

- Add "URI-encoded parameter name = URI-encoded parameter value" to
each parameter. If no value is specified, use a null string instead. The
equal sign (=) is required.
For example, in the following string that contains two parameters, the
value of parameter parm2 is null.
parm1=valuel&parm2=

- Sort the parameters in alphabetically ascending order. For example, a

parameter starting with uppercase letter F precedes another parameter
starting with lowercase letter b.

- Construct standard query strings from the first parameter after sorting.
Example

The following example contains two optional parameters a and b.

GET

/app1/
a=1&b=2

4. Add standard headers (CanonicalHeaders) and end with a CRLF.
Description

List of standard request headers, including all HTTP message headers in the
to-be-signed request. The X-Sdk-Date header must be included to verify the
signing time, which is in the UTC time format YYYYMMDDTHHMMSSZ as
specified in ISO 8601. When publishing an API in a non-RELEASE
environment, you need to specify an environment name.

NOTICE

The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

AP| Gateway checks the time format and compares the time with the time
when API Gateway receives the request. If the time difference exceeds 15
minutes, APl Gateway will reject the request.

Format

CanonicalHeaders consists of multiple message headers, for example,
CanonicalHeadersEntry0 + CanonicalHeadersEntry1 + .... Each message
header (CanonicalHeadersEntry) is in the format of
Lowercase(HeaderName) + "' + Trimall(HeaderValue) + '\n'.

(10 NOTE

e Lowercase: a function for converting all letters into lowercase letters.
e Trimall: a function for deleting the spaces before and after a value.

e The last message header carries a CALF. Therefore, an empty line appears because
the CanonicalHeaders field also contains a CALF according to the specifications.

e The message header name must be unique. Otherwise, authentication fails.

Example

GET
/app1/
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a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

NOTICE

Standard message headers must meet the following requirements:

e All letters in a header are converted to lowercase letters, and all spaces
before and after the header are deleted.

e All headers are sorted in alphabetically ascending order.

For example, the original headers are as follows:

Host: c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com\n
Content-Type: application/json;charset=utf8\n

My-header1: a b ¢ \n

X-Sdk-Date:20191111T093443Z\n

My-Header2: "a b c" \n

A standard header is as follows:

content-type:application/json;charset=utf8\n
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com\n
my-headerl:a b c\n

my-header2:"a b c¢"\n

x-sdk-date:20191111T093443Z\n

Add message headers (SignedHeaders) for request signing, and end with a
CALF.

Description

List of message headers used for request signing. This step is to determine
which headers are used for signing the request and which headers can be
ignored during request verification. The X-Sdk-date header must be included.

Format

SignedHeaders = Lowercase(HeaderNameO0) + ;' + Lowercase(HeaderName1)
+ n.n + .

’

Letters in the message headers are converted to lowercase letters. All headers
are sorted alphabetically and separated with commas.

Lowercase is a function for converting all letters into lowercase letters.
Example

In the following example, two message headers host and x-sdk-date are used
for signing the request.

GET

/app1/

a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

host;x-sdk-date

Use the hash function SHA-256 to create a hash value based on the body
(RequestPayload) of the HTTP or HTTPS request.

Description

Request message body. The message body needs two layers of conversion
(HexEncode(Hash(RequestPayload))). Hash is a function for generating
message digest. Currently, SHA-256 is supported. HexEncode: the Base16
encoding function for returning a digest consisting of lowercase letters. For

2021-10-25



API Gateway
Developer Guide

3 Calling APIs Through App Authentication

example, HexEncode ("m") returns 6d instead of 6D. Each byte you enter is
expressed as two hexadecimal characters.

(1] NOTE

If RequestPayload is null, the null value is used for calculating a hash value.
Example

This example uses GET as an example and leaves the request body empty.
After hash processing, the request body (empty string) is as follows:

GET

/app1/

a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

host;x-sdk-date
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855

7. Perform hash processing on the standard request in the same way as that on
the RequestPayload. After hash processing, the standard request is expressed
with lowercase hexadecimal strings.

Algorithm pseudocode:
Lowercase(HexEncode(Hash.SHA256(CanonicalRequest)))

Example of standard request after hash processing:
af71c5a7ef45310b8dc05ab15f7da50189ffa81a95cc284379ebaa5eb61155c0

Step 2: Creating a To-Be-Signed String

After a standard HTTP request is constructed and the request hash value is
obtained, create a to-be-signed string by combining them with the signature
algorithm and signing time.
StringToSign =

Algorithm + \n +

RequestDateTime + \n +
HashedCanonicalRequest

Parameters in the pseudocode are described as follows:

e Algorithm
Signature algorithm. For SHA256, the value is SDK-HMAC-SHA256.
e RequestDateTime

Request timestamp, which is the same as X-Sdk-Date in the request header.
The format is YYYYMMDDTHHMMSSZ.

e HashedCanonicalRequest

Standard request generated after hash processing.
In this example, the following to-be-signed string is obtained:
SDK-HMAC-SHA256

20191111T093443Z
af71c5a7ef45310b8dc05ab15f7da50189ffa81a95cc284379ebaa5eb61155c0
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Step 3: Calculating the Signature

Use the AppSecret and created character string as the input of the encryption
hash function, and convert the calculated binary signature into a hexadecimal
expression.

The pseudocode is as follows:

signature = HexEncode (HMAC(APP secret, string to sign))

HMAC indicates hash calculation, and HexEncode indicates hexadecimal
conversion. Table 3-1 describes the parameters in the pseudocode.

Table 3-1 Parameter description

Parameter Description

AppSecret Signature key.

To-be-signed string | Character string to be signed.

If the AppSecret is FWTh5tqu2Pb9ZGt8NI09XYZti2V1LTa8useKXMDS, the
calculated signature is as follows:

01cc37e53d821da93bb7239c5b6e1640b184a748f8c20e61987b491e00b15822

Step 4: Adding the Signature to the Request Header

3.3 Java

Scenarios

Add the signature to the HTTP Authorization header. The Authorization header is
used for identity authentication and not included in the signed headers.

The pseudocode is as follows:

Authorization header creation pseudocode:
Authorization: algorithm Access=APP key, SignedHeaders=SignedHeaders, Signature=signature

There is no comma before the algorithm and Access. SignedHeaders and
Signature must be separated with commas.

The signed headers are as follows:

Authorization: SDK-HMAC-SHA256 Access=FM9RLCN****++xxxixN AX|SK, SignedHeaders=host;x-sdk-date,
Signature=01cc37e53d821da93bb7239c5b6e1640b184a748f8c20e61987b491e00b15822

The signed headers are added to the HTTP request for identity authentication. If
the identity authentication is successful, the request is sent to the corresponding
backend service for processing.

To use Java to call an API through App authentication, obtain the Java SDK, create
a new project or import an existing project, and then call the API by referring to
the API calling example.
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This section uses Eclipse 4.5.2 as an example.

Figure 3-1 API calling process

Start

Y
Obtain the SDK.

l

¥
Create a project. IR RS L
project.

Y
Call the APL.

L
End

Prerequisites

e You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.

e You have installed Eclipse 3.6.0 or a later version. If not, download Eclipse
from the official Eclipse website and install it.

e You have installed Java Development Kit (JDK) 1.8.111 or a later version. If
not, download JDK from the official Oracle website and install it.

Obtaining the SDK

Log in to the APl Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description

libs\ SDK dependencies
libs\java-sdk-core-x.x.xjar SDK package
src\com\apig\sdk\demo\Main.java Sample code for signing requests

src\com\apig\sdk\demo\OkHttpDemo.java

src\com\apig\sdk\demo\LargeFileUpload-
Demo.java

.classpath Java project configuration files

.project
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Importing a Project
Step 1 Open Eclipse and choose File > Import.

The Import dialog box is displayed.

Step 2 Choose General > Existing Projects into Workspace and click Next.

The Import Projects dialog box is displayed.

Figure 3-2 Importing a project

& Import

Select

Create new projects from an archive file or directory.

Select an import source:

type filter text

o e
=1

4 (= General
JE Archive File
|[L,-Q' Existing Projects into Workspace

[, File System

] Preferences
> = Git
= Gradle

m

= - —
'ff/' = Back MNext = Finish

Step 3 Click Browse and select the directory where the SDK is decompressed.

2021-10-25
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Figure 3-3 Selecting the demo project

S Import = &=
Import Projects E f
-

Select a directory to search for existing Eclipse projects.

@ Select root directory: | DtYjava©\ApiGateway-java-sdk- - Browse... l
() Select archive file: Browse...
Projects:

java-sdk-demo (D¥\java\ApiGateway-java-sdhk- I Select All

Deselect All

Refresh

i

Options
[[] Search for nested projects
[ Copy projects into workspace
[[|Hide projects that already exist in the workspace
Working sets
[[] Add project to working sets

Select...

'i?::' Mext = Finish ] ’ Cancel

Step 4 Click Finish.

Modify the parameters in sample code Main.java as required. For details about
the sample code, see API Calling Example.

--—-End

Creating a Project
Step 1 Open Eclipse and choose File > New > Java Project.
The New Java Project dialog box is displayed.

Step 2 Enter a project name, for example, java-sdk-demo, retain the default settings for
other parameters, and click Finish.
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Figure 3-4 Creating a project

&= New Java Project = I@
Create a Java Project —
Create a Java project in the workspace or in an external location.

Project name: java-sdk-demo

Use default location

ChlUsersiwx32902 M\ workspaceljava-sdk-demo Browse...
JRE
@ Use an execution enviranment JRE: JavaSE-1.8 -
i7) Use a project specific JRE: jrel.8.0 191
(71 Use default JRE {currently jrel.8.0 191" Configure JREs...

Project layout

71 Use project folder as root for sources and class files

@ Create separate folders for sources and class files  Configure default...

Working sets
[[] Add project to working sets

Select...

@' = Back Mext = ] [ Finish l ’ Cancel

Step 3 Import the .jar files in the APl Gateway Java SDK.

1. Choose java-sdk-demo, right-click, and choose Build Path > Add External
Archives from the shortcut menu.
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2.

Figure 3-5 Importing the .jar files

4 |l java=dl-d '
'FLE%’ g Mew 4
b o J Go Into
Open in New Window
Dpen Type Hierarchy F
Show In Alt+Shift+W ¥
Copy Ctrl+C
EZ  Copy Qualified Name
[} Paste Cirl+V
H  Delete Delete
Remove from Context Ctrl+Alt+Shift+Down
Build Path 1 v | Zm  Link Source...
Source Alt+Shift+S v | &9 MNew Source Folder...
Refactor Alt+Shift+T » 6B Use as Source Folder
i Import.. 2 s Add External Archives...
g Export.. =\ Add Libraries...
«5 Refresh FS | g Configure Build Path...

Select all .jar files in the \libs directory.

Figure 3-6 Selecting all .jar files

| commons-codec-1.11jar 2019/3/15 10:23  Executable Jar File 328 KB|
| =] commons-logging-1.2jar 2019/3/15 10:23 Executable Jar File 61 KB |
| =] httpclient-4.5.5.jar 2019/3/15 10:23  Executable Jar File 749 KB |
| ] httpcore-4.4.9.jar 2019/3/15 10:23  Executable Jar File 318 KB|
| =] java-sdk-core-3.0.9.jar 2019/3/15 10:23  Executable lar File 101 KB |
| 2] joda-time-2.9.9,jar 2019/3/15 10:23  Executable Jar File 620 KB |
| €] okhttp-3.11.0,jar 2019/3/15 10:23  Executable Jar File 404 KB |
| =] okio-1.15.0,ar 2019/3/15 10:23  Executable Jar File 87 KB |

Step 4 Create a package and Main file.

1. Choose src, right-click, and choose New > Package from the shortcut menu.

Figure 3-7 Creating a package
4 (= java-sdk-demo

blfﬁ—; 1 ¥ |22 Java Project
4 = R Open in New Window wi |z
b fme Open Type Hierarchy F4 2
b 'E Show In Alt+Shift+ W | & Class
E :; Copy Ctrl+C € Interface
« B B3 | Conv Oualfied Name B

2. Enter com.apig.sdk.demo for Name.

2021-10-25 14



API Gateway
Developer Guide 3 Calling APIs Through App Authentication

Figure 3-8 Setting a package name

& Mew Java Package | = '@

Java Package
Create a new Java package.

Creates folders corresponding to packages.

Source folder: java-sdk-demojfsrc

Mame: com.apig.sdk.demo

[| Create package-infojava

@' Einish l ’ Cancel

3. Click Finish.
The package is created.

4. Choose com.apig.sdk.demo, right-click, and choose New > Class from the
shortcut menu.

Figure 3-9 Creating a class
4 [ java-sdk-demao

4 (B grg
E . L 1 I

- @ JRE 1 | 2% Java Project
4 m) Refe Open in New Window [ Project..

¢ fma g Open Type Hierarchy F4 | §F Package

» 59 Showln Alt+Shift+W » 2

> foig }‘

. oy H 2 Copy cirlec | G Interface

> g i B Copy Qualified Name & Enum

. s ji [ Paste Ctrl+V ® Annotation

5. Enter Main for Name and select public static void main(String[] args).
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Figure 3-10 Configuring the class

= New Java Class

5]l

]

Java Class =
Create a new Java class.
Source folder: Java-sdk-demo/src
com.apig.sdk.demo
Browse...

Package:

[[]Enclosing type:

Modifiers: @ public (") package private protected
[] abstract [ final static
Superclass: java.lang.Object
Interfaces: Add...
Eemove
Which method stubs would you like to create?
| [lipublic static void main(String[] args);
[7] Constructors from superclass
[¥] Inherited abstract methods
Do you want to add comments? (Configure templates and default value here
|:| Generate comments
[ Cancel

l

Finish

@

6. Click Finish.
The Main file is created.

Step 5 View the directory structure of the project.

16
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Figure 3-11 Directory structure of the new project Main
4 [ java-sdk-demo
4 [ src
4 3} com.apig.sdlk.demo
[ 1] Mainjavai|
- Bl JRE System Library [JavaSE-1.8]

4 @), Referenced Libraries

jms commons-codec-1.11,jar - [
jms commons-logging-1.2.jar -|D:
oo httpclient-4.3.5,jar - D\javalAp
jma hittpcore-4.4.9.ar - 0t java\Pipi
jon java-sdlk-core-3.0.9,jar - D:jav
jwe joda-time-2.9.9jar - DV javd\ 4
s okhttp-3.11.0jar - 0:java' 4pit

jma okio-1.15.0ar - D:\java' Ap|Ga

Before using Main.java, enter the required code according to the API calling
example provided in this section.

--—-End

API Calling Example

Step 1

Step 2

(1 NOTE

e You need to create an APl with the Mock backend on the console, and then publish the
API. For details about how to create and publish an API, see the User Guide .

e The backend of this API is a fake HTTP service, which returns response code 200 and
message body Congratulations, sdk demo is running.

Add the following references to Main.java:

import java.io.lOException;
import javax.net.ssl.SSLContext;

import org.apache.http.Header;

import org.apache.http.HttpEntity;

import org.apache.http.HttpResponse;

import org.apache.http.client. methods.HttpRequestBase;
import org.apache.http.conn.ssl. AllowAllHostnameVerifier;
import org.apache.http.conn.ssl.SSLConnectionSocketFactory;
import org.apache.http.conn.ssl.SSLContexts;

import org.apache.http.conn.ssL.TrustSelfSignedStrategy;
import org.apache.http.impl.client.CloseableHttpClient;
import org.apache.http.impl.client.HttpClients;

import org.apache.http.util.EntityUtils;

import com.cloud.apigateway.sdk.utils.Client;
import com.cloud.apigateway.sdk.utils.Request;

Construct a request by configuring the following parameters:

e AppKey: Obtain it by referring to Preparation. The sample code uses
4f5f626b-073f-402f-a1e0-e52171¢c6100c.

e AppSecret: Obtain it by referring to Preparation. Set this parameter based on
the site requirements. The example code uses ****** as an example.
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Step 3

Method: Specify a request method. The sample code uses POST.

url: Request URL of the API, excluding the QueryString and fragment parts.
Use your own independent domain name. The sample code uses http://
€967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/java-
sdk.

queryString: Specify query parameters to be carried in the URL. Characters
(0-9a-zA-Z./;[1\-=~#%"&_+:") are allowed. The sample code uses
name=value.

Header: Request header. Set a request header as required. It cannot contain
underscores (_). The sample code uses Content-Type:text/plain. If you are
going to publish the API in a non-RELEASE environment, specify an
environment name. The sample code uses x-stage:publish_env_name.

body: Specify the request body. The sample code uses demo.

The sample code is as follows:

app.

Request request = new Request();
try

{
request.setKey("4f5f626b-073f-402f-a1e0-e52171c¢6100c"); //Obtain the value when creating an

request.setSecret("*****"); //Obtained when an app is created.
request.setMethod("POST");
request.setUrl("http://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/java-

sdk™);

//URL
request.addQueryStringParam("name", "value");
request.addHeader("Content-Type", "text/plain");

non

//request.addHeader("x-stage", "publish_env_name"); //Specify an environment name before

publishing the APl in a non-RELEASE environment.

request.setBody("demo");
} catch (Exception e)
{
e.printStackTrace();
return;

}

Sign the request, access the API, and print the result.

The sample code is as follows:

CloseableHttpClient client = null;

try
{
HttpRequestBase signedRequest = Client.sign(request);

client = HttpClients.custom().build();
HttpResponse response = client.execute(signedRequest);
System.out.println(response.getStatusLine().toString());
Header[] resHeaders = response.getAllHeaders();
for (Header h : resHeaders)
{

System.out.println(h.getName() + ":" + h.getValue());
}
HttpEntity resEntity = response.getEntity();
if (resEntity != null)

System.out.println(System.getProperty("line.separator") + EntityUtils.toString(resEntity, "UTF-8"));
}

} catch (Exception e)

{
e.printStackTrace();

} finally
{
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Step 4 Choose Main.java, right-click, and choose Run As > Java Application to run the

try
if (client != null)

client.close();

}
} catch (IOException e)

{

}
}

e.printStackTrace();

project test code.

Figure 3-12 Running the project test code

main(string[] args) {
request.
= new Request();

equest parameters.

ppSecrect, Method and Url are required
ey("871fe245-9cf6-4d75-822d-c29945alel
secret("c6e52419-227@8-4ch3-8bd4-ae7fdde
ethod("GET");
Url("https://30@30113-3657-4fh6-a7ef-98
QueryStringParam("name”, "value");
Header("Content-Type”, “"text/plain”);
published in other gnvs(except for Rel

4 [ java-sdk-demo g FETeT mmmrmpgn mun e
> @ JRE System Library [jre1.8.0_191] 4 //Import the external dependencies.
4 (B src 5_ . . . .
. I‘B com.apig.sdk.demo ,\,-,246.-# import java.io.IOException;[]
> ] LargeFileUploadDema.java 25 public class Main {
s [0 M =
> % Ok New ’
> @i Referenc Open F3
s (= libs Open With '
2/ changelg Open Type Hierarchy F4
Show In Alt+Shift+W »
[E Copy Ctrl+C
2 Copy Qualified Name
& Paste Ctrl+V
H Delete Delete

Remaove from Context
Build Path
Source

Refactor

fa  Import..

0y  Export.

References

Declarations

" Refresh

Debug As

Vialidas~

Assign Working Sets...

Ctrl+Alt+Shift+ Down
3
Alt+Shift+5 »
Alt+Shift+T »

F5

-

ddHeader|(|"x-stage”, "publish_env_name™)
gody ( “demo™);

ion e) {

Trace();

ient client = null;

request.
Base signedRequest = Client.sign(reques
h : signedRequest.getAllHeaders()) {

put.println(h.getName() + ":" + h.getva
brintln("---------nn "y
request.

sslContext = SSiCentexts.custon().leadT

pnsocketFactory sslSocketFactory = new .

1 |1 Java Application Alt+Shift+X, J
3

Run Configurations...

Step 5 On the Console tab page, view the running result.
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3.4 Go

Scenarios

Prerequisites

Figure 3-13 Response displayed if the calling is successful

'*| Problems |5\ Declaration B Conscle 2

=terminated= Main [Java Application] C:\Program Files\Javaijrel.8.0_191\bin\javaw.exe

HTTP/1.1

Date:Tue, 19 Mar 2019 @8:38:28 GMT
Content-Type:application/json
Transfer-Encoding:chunked
Connection:keep-alive

Server:api-gateway
X-Request-Id:844732a996756668d8d312ea362c9ea4)]
Access-Control-Allow-Origin:®

knngratulatians, sdk demo is runningl

--—-End

To use Go to call an API through App authentication, obtain the Go SDK, create a
new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2018.3.5 as an example.

e You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.

e You have installed the Go programming language. If not, download the Go
installation package from the official Go website and install it.

e You have installed IntelliJ IDEA. If not, download Intelli) IDEA from the official
Intelli) IDEA website and install it.

e You have installed the Go plug-in on IntelliJ IDEA. If not, install the Go plug-in
according to Figure 3-14.
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Figure 3-14 Installing the Go plug-in
B settings @

Q- Plugins 2 Installed Updates (0) o Reset
Appearance & Behavior
fee 13

Keymap
. Search Results (191)
Editor
I o - o Tempiate
Version Control B Llanguages B languages
Build, Execution, Deployment This plugin extends Intelli) Support for Go template
platform with Go-specific engine

Languages & Frameworks

coding as

ance and tool (https://golang.org/pkg/text/t

oot L 781K 4, e 019 501K w47
GoToTabs Go To Project
Navigation Navigation

The plugin adds menu actions Enables opening project

allowing you to go to a windows with speed search.

specific tab. You can of. . -
c 03,2017 & 75

[«] 08, 2015 + 73K &5

@ ol | [ ooy

Obtaining the SDK

Log in to the API Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description
core\escape.go SDK code
core\signer.go

demo.go Sample code

Creating a Project

Step 1 Start IntelliJ IDEA and choose File > New > Project.
On the displayed New Project page, choose Go and click Next.
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Figure 3-15 Go

Mew Project

Step 2 Click ..., select the directory where the SDK is decompressed, and click Finish.

Step 3 View the directory structure shown in the following figure.

= Java
Java Enterprise
:, JBoss
0 J2mE
M Clouds
Spring
w Java FX
Android
Intelli) Platfarm Plugin

© Spring Initializr
Maven

Gradle

8 Groovy
Grails
Application Forge

“ Go Modules (vgo)

Mew Project

=Mo SDK=
[ Index entire GOPATH

Additional Libraries and Frameworks:

1.2, SQL Support

Default Dialect:

|

Cancel

Help

Figure 3-16 Selecting the SDK directory of Go after decompression

=5

Project name: | gc-|

Project location: | Dt\java\go

b More Settings

Previous

Cancel

Help
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Figure 3-17 Directory structure of the new project go
b Jidea
v ApiGateway-go-sdhk-
v core
© escape.go
* signer.go
> go
> licenses
“ demao.go

mJo.iml

Modify the parameters in sample code demo.go as required. For details about the
sample code, see API Calling Example.

--—-End

API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Import the Go SDK (signer.go) to the project.
import "apig-sdk/go/core"

Generate a new signer and enter the AppKey and AppSecret.

s := core.Signer{
Key: "4f5f626b-073f-402f-a1e0-e52171c6100c",
Secret; "R,

}

Generate a new request, and specify the domain name, method, request URL,
query parameters, and body.

r, _ = http.NewRequest("POST", "http://c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com/api?a=1&b=2",
ioutil. NopCloser(bytes.NewBuffer([]byte("foo=bar"))))

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
r.Header.Add("x-stage", "RELEASE")

Execute the following function to add the X-Sdk-Date and Authorization headers
for signing:
s.Sign(r)

Access the APl and view the access result.

resp, err := http.DefaultClient.Do(r)
body, err := ioutil.ReadAll(resp.Body)

--—-End
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3.5 Python

Scenarios

To use Python to call an API through App authentication, obtain the Python SDK,
create a new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2018.3.5 as an example.

Preparing the Environment

e You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.

e You have installed Python 2.7.9 or 3.X. If not, download the Python
installation package from the official Python website and install it.

After Python is installed, run the pip command to install the requests library
in the CLI or Shell window.

pip install requests

(11 NOTE

If a certificate error occurs during the installation, download the get-pip.py file to
upgrade the pip environment, and try again.

e You have installed Intelli) IDEA. If not, download Intelli) IDEA from the official
Intelli) IDEA website and install it.

e You have installed the Python plug-in on IntelliJ IDEA. If not, install the
Python plug-in according to Figure 3-18.

Figure 3-18 Installing the Python plug-in

Settings e
Q- Plugins Marketplace| 2 Installed Updates -1
Appearance & Behavior
- ] 3
Keymap
. Search Results (41)
Editor
BEED e Mictopythan
Version Control Languages Framework integration
Build, Execution, Deployment The Python plug-in provides Support for MicroPython
Languages & Frameworks smart editing for Python devices in Intelli) IDEA and

ripts. The feature set of the PyCharm. Features: Code

oot tr3.0 o 12,2019 4 337K 1749
Live Coding in Python python-typing-adder
Code tools Code tools
Lets you run your Python READ sing intellij to infer
code as you type it. Displays yping and add type
variable values, matplotlib, or. comments using the typing
14, 2018 + 157K c 14, 2017 + { 12
Py o
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Obtaining the SDK

Log in to the API Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description

apig_sdk\__init__.py SDK code

apig_sdk\signer.py

main.py Sample code
backend_signature.py Sample code for backend signing
licenses\license-requests Third-party license

Creating a Project
Step 1 Start IDEA and choose File > New > Project.
On the displayed New Project page, choose Python and click Next.

Figure 3-19 Python

Mew Project @
Maven Project SDK: | Python 3.7.2 - New...
Gradle Additional Libraries and Framewaorks:

G Groovy 16N Djange
Grails [ Google App Engine (Python)
Application Forge [ 25, 5QL Support

© Go

“ Go Modules (vgo)
= Dep
& App Engine

Static Web

E Flash Template language:

Templates folder: templates

. Application name:
E Kotlin

Empty Project T 2

Next Cancel Help

Step 2 Click Next. Click ..., select the directory where the SDK is decompressed, and click
Finish.
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Figure 3-20 Selecting the SDK directory after decompression
Mew Project @

Project name: | py‘thonl |

Project location: | D:\java\python

b More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.

Figure 3-21 Directory structure of the new project python

v python
b Jidea
v ApiGateway-python-sdk-
v apig_sdk
_init__.py
signer.py
> licenses
main.py

test_signer.py
m Eython.iml

Modify the parameters in sample code main.py as required. For details about the
sample code, see API Calling Example.

--—-End

API Calling Example

Step 1 Import apig_sdk to the project.

from apig_sdk import signer
import requests

Step 2 Generate a new signer and enter the AppKey and AppSecret.
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Step 3

Step 4

Step 5

3.6 C#

Scenarios

sig = signer.Signer()
sig.Key = "4f5f626b-073f-402f-a1e0-e52171c6100c"
Sig_Secret Mkt

Generate a request, and specify the method, request URI, header, and request
body.

r = signer.HttpRequest("POST",
"https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?a=1",
{"x-stage": "RELEASE"},
"body")

Execute the following function to add the X-Sdk-Date and Authorization headers
for signing:

(11 NOTE

X-Sdk-Date is a request header parameter required for signing requests.
sig.Sign(r)

Access the APl and view the access result.

resp = requests.request(r.method, rscheme + "://" + rhost + r.uri, headers=r.headers, data=r.body)
print(resp.status_code, resp.reason)
print(resp.content)

--—-End

To use C# to call an API through App authentication, obtain the C# SDK, open the
project file in the SDK, and then call the API by referring to the API calling
example.

Preparing the Environment

e You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.

e You have installed Visual Studio. If not, download it from the official Visual
Studio website and install it.

Obtaining the SDK

Log in to the API Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description

apigateway-signature\Signer.cs SDK code

apigateway-signature\HttpEncoder.cs

sdk-request\Program.cs Sample code for signing requests
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Name Description

backend-signature\ Sample project for backend signing
csharp.sin Project file
licenses\license-referencesource Third-party license

Opening a Project

Double-click csharp.sln in the SDK package to open the project. The project
contains the following:

e apigateway-signature: Shared library that implements the signature
algorithm. It can be used in the .Net Framework and .Net Core projects.
e backend-signature: Example of a backend service signature.

o sdk-request: Example of invoking the signature algorithm. Modify the
parameters as required. For details about the sample code, see API Calling
Example.

API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Import the C# SDK to your project.
using APIGATEWAY_SDK;

Generate a new signer and enter the AppKey and AppSecret.

Signer signer = new Signer();
signer.Key = "4f5f626b-073f-402f-a1e0-e52171c6100c";
signer.Secret = "rirert

Generate an HttpRequest, and specify the method, request URL, and body.

HttpRequest r = new HttpRequest("POST",

new Uri("https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?
query=value"));
rbody = "{\"a\":1}";

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.

r.headers.Add("x-stage", "RELEASE");

Execute the following function to generate HttpWebRequest, and add the X-Sdk-
Date and Authorization headers for signing the request:

HttpWebRequest req = signer.Sign(r);

Access the APl and view the access result.

var writer = new StreamWriter(req.GetRequestStream());
writer.Write(r.body);

writer.Flush();

HttpWebResponse resp = (HttpWebResponse)req.GetResponse();
var reader = newStreamReader(resp.GetResponseStream());
Console.WriteLine(reader.ReadToEnd());

--—-End
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3.7 JavaScript

Scenarios

To use JavaScript to call an API through App authentication, obtain the JavaScript

SDK, create a new project, and then call the API by referring to the API calling

example.

JavaScript SDKs can be run in Node.js and browsers.

This section describes the procedure of using Intelli) IDEA 2018.3.5 to establish a

Node.js environment. It also provides examples of calling APIs using a browser.

Preparing the Environment

e You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.

e You have installed the Node.js programming language. If not, download the
Node.js installation package from the official Node.js website and install it.

e You have installed IntelliJ IDEA. If not, download Intelli) IDEA from the official
Intelli) IDEA website and install it.

e You have installed the Node.js plug-in on Intelli) IDEA. If not, install the

Python plug-in according to Figure 3-22.

Figure 3-22 Installing the Node.js plug-in

Settings

Q-

Obtaining the SDK

Appearance & Behavior
Keymap

Editor

Version Control

Build, Execution, Deployment

Languages & Frameworks

Tools

Plugins 2 Installed Updates g
o] 3

Search Results (6)

NodeJs Node.js Remote Interpreter
JavaScript Network

Support for Node,js projects.

Features Run Node.js applications in the remote

applications from the IDE and environments

Run and debug Node,js

LiveEdit Beame Insta-ssl plugin
Web Network
With Live Edit you can see the Beame.io Jetbrains plugin

changes you made in your Beame-in provides

r exposing

17 £ 25K

Cancel

such as Docker

Log in to the APl Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.
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The following table shows the files decompressed from the package.

Name

Description

signer.js

SDK code

node_demo.js

Node.js sample code

demo.html

Browser sample code

demo_require.html

require)

Browser sample code (loaded using

test.js

Test case

js\hmac-sha256.js

Dependencies

licenses\license-crypto-js

Third-party licenses

licenses\license-node

Creating a Project

Step 1 Start Intelli) IDEA and choose File > New > Project.

In the New Project dialog box, choose Static Web and click Next.

Figure 3-23 Static Web

MNew Project

Gradle

8 Groovy

Grails

Application Forge
o Go
% Go Modules (vgo)
% Dep
s App Engine

&) Static Web

(2 Nodejs and NPM
E Flash

K Kotlin

Python

Empty Project

Step 2 Click ..., select the directo

‘@

) Static Web

[ HTMLS Boilerplate
& React App

B Foundation

[ Bootstrap

Q) Angular)s

¥ Angular CLI

4% React Native

Web modules are used for developing Web applications using
technologies such as HTMLJ/CSS, JavaScript, PHP and so on. They do
not support developing Java applications.

2
Iml Cancel Help

ry where the SDK is decompressed, and click Finish.
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Figure 3-24 Selecting the SDK directory of JavaScript after decompression
MNew Project @

Project name: |Ja\raScript |

Project location: | D:\java'JavaScript

b Maore Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.

Figure 3-25 Directory structure of the new project JavaScript
W JavaScript

> idea

v ApiGateway-javascript-sdl-2.0.0
> IE
> licenses

i dema.html
i demo_require.html
5= node_demojs
1 package-lockjsan
i signergs
5 testjs
mJavaScriptiml
Il External Libraries

Scratches and Consoles

e node_demao.js: Sample code in Node.js. Modify the parameters in the sample

code as required. For details about the sample code, see API Calling Example
(Node.js).

demo.html: Browser sample code. Modify the parameters in the sample code

as required. For details about the sample code, see API Calling Example
(Browser).
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Step 4 Click Edit Configurations.

Figure 3-26 Click Edit Configurations

Edit Configurations...

FH Save 'main’ Configuration

main
Step 5 Click + and select Node.js.

Figure 3-27 Selecting Node.js
Run/Debug Configurations

1] - m £ w

Add Mew Configuration

- l_IIUU'i'J'

£ Gruntjs

i

¥ Gulpjs
| JAR Application
55 JavaScript Debug
ﬁ lest

Ab JUnit

i Jupyter Notebook
K Kotlin

K Kotlin script

D Lettuce

M Maven

@ Mocha

5] Modeunit

Step 6 Set JavaScript file to node_demo.js and click OK.

Figure 3-28 Selecting node_demao.js

Run/Debug Configurations @
+ — B F [ 1 Name: | node demo.js [1share []Allow parallel run
~ (2 Nodejs . . . .
. : Configuration Browser / Live Edit V8 Profiling Logs
Cerfousion
> ¢ Python Naode interpreter: Project node (D3 \node.exe) 10153 ~ || o

> JTemplates

Nade parameters:

Working directory: D:\java\JavaScript\ApiGateway-javascript-sdk-2.0.0

JavaScript file: node_dema,js

Application parameters:

Environment variables:

--—-End
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API Calling Example (Node.js)

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Import signer.js to your project.

var signer = require('./signer')
var http = require(‘http')

Generate a new signer and enter the AppKey and AppSecret.

var sig = new signer.Signer()
sig.Key = "4f5f626b-073f-402f-a1e0-52171c6100c"
Sig.secret = Mkkkkkkil

Generate a request, and specify the method, request URI, and request body.

var r = new signer.HttpRequest("POST", "c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com/app1?a=1");
rbody ='{"a":1}

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
rheaders = { "x-stage":"RELEASE" }

Execute the following function to generate HTTP(s) request parameters, and add
the X-Sdk-Date and Authorization headers for signing the request:
var opt = sig.Sign(r)

Access the APl and view the access result. If you access the APl using HTTPS,
change http.request to https.request.

var reg=http.request(opt, function(res){
console.log(res.statusCode)
res.on("data"”, function(chunk){
console.log(chunk.toString())
)
)
reg.on("error",function(err){
console.log(err.message)
)
req.write(r.body)
req.end()

--—-End

API Calling Example (Browser)

Step 1

Step 2

Before calling an APl with a browser, create an API that supports the OPTIONS
method by following the instructions in "Enabling CORS" in the User Guide. When
creating the API, enable CORS and add Access-Control-Allow-* fields in the
response header.

Import signer.js and dependencies to the HTML page.

<script src="js/hmac-sha256.js"></script>

<script src="js/moment.min.js"></script>

<script src="js/moment-timezone-with-data.min.js"></script>
<script src='signer.js'></script>

Sign the request and access the API.

var sig = new signer.Signer()

sig.Key = "4f5f626b-073f-402f-a1e0-e52171c6100c"

sig.Secret = "rrirRxn

var r= new signer.HttpRequest()

r.host = "c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com”
r.method = "POST"

ruri = "/app1"

rbody ='{"a":1}
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3.8 PHP

Scenarios

rquery = { "a":"1","b":"2" }
rheaders = { "Content-Type":"application/json" }
var opt = sig.Sign(r)
var scheme = "https"
$.ajax({
type: opts.method,
data: req.body,
processData: false,
url: scheme + "://" + opts.hostname + opts.path,
headers: opts.headers,
success: function (data) {
$('#status').html('200')
$('#recv').html(data)
%
error: function (resp) {
if (resp.readyState === 4) {
$('#status').html(resp.status)
$('#recv').html(resp.responseText)
}else {
$('#status').html(resp.state())
}

timeout: 1000
b

--—-End

To use PHP to call an API through App authentication, obtain the PHP SDK, create

a new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2018.3.5 as an example.

Preparing the Environment

e You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.

e You have installed Intelli) IDEA. If not, download Intelli) IDEA from the official
Intelli) IDEA website and install it.

e You have installed the PHP programming language. If not, download the PHP
installation package from the official PHP website and install it.

e  Copy the php.ini-production file from the PHP installation directory to the C:
\windows\ directory, rename the file as php.ini, and then add the following
lines to the file:
extension_dir = "PHP installation directory/ext"
extension=openssl
extension=curl

e You have installed the PHP plug-in on Intelli) IDEA. If not, install the PHP

plug-in according to Figure 3-29.
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Figure 3-29 Installing the PHP plug-in

Bl setirg: =
Q- Plugins Marketplace Installed Updates -
Appearance & Behavior
°P Q 2
Keymap
) Search Results (129)
Editor
BN . PHP Annotations
Version Control Languages Framework integration
Build, Execution, Deployment PHP 5.3-7.3 editing and PHP Annotation GitHub |
Languages & Frameworks de::uggil‘g 3I—13L,|.*i'. Smarty, :EELIEIE | Donate Installation
Twig and various frameworks Just install and be happy
UEEE c 08,2019 % 1.9M 3.5 $11M was
PHP Toolbox PHP composer.json support
Framework integration Code editing
PHP Toolbox GitHub | Json PHP composer.json support
Examples | Donate This plugin Donate using PayPal or
provides thod Bitcoin This plugin adds auto
7,2017 £ 150.5K w5 ES AK w5
(] Cancel

Obtaining the SDK

Log in to the API Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description
signer.php SDK code
index.php Sample code

Creating a Project
Step 1 Start IDEA and choose File > New > Project.
On the displayed New Project page, choose PHP and click Next.
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Figure 3-30 PHP
Bl New Project @

& Groovy I} PHP Empty Project

Grails @ Composer Project

Application Forge
o Go
“ Go Modules (vgo)
& Dep
% App Engine

Static Web
(2 Nodejs and NPM

E Flash

PHP
l | Create empty project for PHP
Kotlin
Pythan
= Empty Project

Cancel Help

Step 2 Click ..., select the directory where the SDK is decompressed, and click Finish.

Figure 3-31 Selecting the SDK directory of PHP after decompression
New Project @

Project name: | php

Project location: | D:\java\php |

b More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.
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Figure 3-32 Directory structure of the new project php
v [Lphp
¥ idea
v ApiGateway-php-sdl-
o index.php
ahs Signer.php
m Php.iml
» External Libraries

Scratches and Consoles

Modify the parameters in sample code signer.php as required. For details about
the sample code, see API Calling Example.

--—-End

API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

3.9 C++

Scenarios

Import the PHP SDK to your code.

require 'signer.php’;

Generate a new signer and enter the AppKey and AppSecret.

$signer = new Signer();
$signer->Key = '4f5f626b-073f-402f-a1e0-e52171c6100c’;
$signer->Secret = "rrREn,

Generate a new request and specify the method, request URL, and body. (The
body should contain the actual request content.)

$req = new Request('GET', "https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/
app1?a=1");
$req->body = ";

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
$req->headers = array(
'x-stage' => 'RELEASE',
)i
Execute the following function to generate a $Scurl context variable.
$curl = $signer->Sign($req);

Access the APl and view the access result.

$response = curl_exec($curl);

echo curl_getinfo($curl, CURLINFO_HTTP_CODE);
echo $response;

curl_close($curl);

----End

To use C++ to call an API through App authentication, obtain the C++ SDK, and
then call the API by referring to the API calling example.
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Preparing the Environment

1. Obtain the domain name, request URL, and request method of the API to be
called, and the AppKey and AppSecret of the app for calling the API. For more
information, see Preparation.

2. Install the OpenSSL library.
apt-get install libssl-dev

3. Install the curl library.
apt-get install libcurl4-openssl-dev

Obtaining the SDK

Log in to the API Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description
hasher.cpp SDK code
hasher.h

header.h

RequestParams.cpp

RequestParams.h

signer.cpp

signer.h

Makefile Makefile file
main.cpp Sample code

API Calling Example

Step 1

Step 2

Step 3

Step 4

Add the following references to main.cpp:

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.h"

Generate a new signer and enter the AppKey and AppSecret.
Signer signer("4f5f626b-073f-402f-a1e0-e52171c6100c", "*+**");

Generate a new RequestParams request, and specify the method, domain name,
request URI, query strings, and request body.

RequestParams* request = new RequestParams("POST", "c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com", "/app1",
"Action=ListUsers&Version=2010-05-08", "demo");

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
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Step 5

Step 6

request->addHeader("x-stage", "RELEASE");

Execute the following function to add the generated headers to the request

variable.
signer.createSignature(request);

Use the curl library to access the API and view the access result.

static size_t

WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)

{

}

size_t realsize = size * nmemb;
struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);

if (mem->memory == NULL) {
/* out of memory! */
printf("not enough memory (realloc returned NULL)\n");
return O;

}
memcpy (&(mem->memory[mem->size]), contents, realsize);
mem->size += realsize;

mem->memory[mem->size] = 0;

return realsize;

//send http request using curl library
int perform_request(RequestParams* request)

{

CURL *curl;

CURLcode res;

struct MemoryStruct resp_header;
resp_header.memory = (char*)malloc(1);
resp_header.size = 0;

struct MemoryStruct resp_body;
resp_body.memory = (char*)malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, request->getMethod().c_str());
std::string url = "http://" + request->getHost() + request->getUri() + "?" + request->getQueryParams();

curl_easy_setopt(curl, CURLOPT_URL, url.c_str());
struct curl_slist *chunk = NULL;
std::set<Header>:iterator it;

for (auto header : *request->getHeaders()) {

std::string headerEntry = header.getKey() + ": " + header.getValue();

printf("%s\n", headerEntry.c_str());

chunk = curl_slist_append(chunk, headerEntry.c_str());
}
printf("------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);

curl_easy_setopt(curl, CURLOPT_COPYPOSTFIELDS, request->getPayload().c_str());

curl_easy_setopt(curl, CURLOPT_NOBODY, OL);

curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);

//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res = CURLE_OK) {

fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));

else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
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printf(resp_body.memory);

}

free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);

curl_global_cleanup();

return O;

}

Step 7 Run the make command to obtain a main executable file, execute the file, and

then view the execution result.

--—-End

310C

Scenarios

To use C to call an API through App authentication, obtain the C SDK, and then
call the API by referring to the API calling example.

Preparing the Environment

1. Obtain the domain name, request URL, and request method of the API to be
called, and the AppKey and AppSecret of the app for calling the API. For more

information, see Preparation.

2. Install the OpenSSL library.
apt-get install libssl-dev

3. Install the curl library.

apt-get install libcurl4-openssl-dev

Obtaining the SDK

Log in to the APl Gateway console, and download the SDK on the SDKs page by

referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name

Description

signer_common.c

signer_common.h

SDK code

signer.c
signer.h
Makefile Makefile file
main.c Sample code
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API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Add the following references to main.c:

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.n"

Generate a sig_params_t variable, and enter the AppKey and AppSecret.

sig_params_t params;

sig_params_init(&params);

sig_str_t app_key = sig_str("4f5f626b-073f-402f-a1e0-e52171c6100c");
sig_str_t app_secret = sig_str("******");

params.key = app_key;

params.secret = app_secret;

Specify the method, domain name, request URI, query strings, and request body.

sig_str_t host = sig_str("c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com");
sig_str_t method = sig_str("GET");

sig_str_t uri = sig_str("/app1");

sig_str_t query_str = sig_str("a=1&b=2");

sig_str_t payload = sig_str("");

params.host = host;

params.method = method;

params.uri = uri;

params.query_str = query_str;

params.payload = payload;

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
sig_headers_add(&params.headers, "x-stage", "RELEASE");

Execute the following function to add the generated headers to the request
variable.
sig_sign(&params);

Use the curl library to access the API and view the access result.

static size_t
WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)
{

size_t realsize = size * nmemb;

struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);
if (mem->memory == NULL) {

/* out of memory! */

printf("not enough memory (realloc returned NULL)\n");

return O;

}

memcpy (&(mem->memory[mem->size]), contents, realsize);
mem->size += realsize;
mem->memory[mem->size] = 0;

return realsize;

}

//send http request using curl library
int perform_request(RequestParams* request)
{
CURL *curl;
CURLcode res;
struct MemoryStruct resp_header;
resp_header.memory = malloc(1);
resp_header.size = 0;

2021-10-25

41



API Gateway
Developer Guide

3 Calling APIs Through App Authentication

}

struct MemoryStruct resp_body;
resp_body.memory = malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, params.method.data);
char url[1024];
sig_snprintf(url, 1024, "http://%V%V?%V", &params.host, &params.uri, &params.query_str);
curl_easy_setopt(curl, CURLOPT_URL, url);
struct curl_slist *chunk = NULL;
for (inti = 0; i < params.headers.len; i++) {
char header[1024];
sig_snprintf(header, 1024, "%V: %V", &params.headers.data[i]l.name, &params.headers.datali].value);
printf("%s\n", header);
chunk = curl_slist_append(chunk, header);

printf("------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);
curl_easy_setopt(curl, CURLOPT_POSTFIELDS, params.payload.data);
curl_easy_setopt(curl, CURLOPT_NOBODY, OL);
curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);
//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res !'= CURLE_OK) {

fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));

else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
printf(resp_body.memory);

free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);

curl_global_cleanup();
//free signature params

sig_params_free(&params);
return 0;

Step 7 Run the make command to obtain a main executable file, execute the file, and
then view the execution result.

--—-End

3.11 Android

Scenarios

To use Android to call an API through App authentication, obtain the Android SDK,
create a new project, and then call the API by referring to the API calling example.

Preparing the Environment

You have obtained the domain name, request URL, and request method of the
API to be called, and the AppKey and AppSecret of the app for calling the API.
For more information, see Preparation.
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e You have installed Android Studio. If not, download Android Studio from the

official Android Studio website and install it.

Obtaining the SDK

Log in to the API Gateway console, and download the SDK on the SDKs page by
referring to section "SDKs" in the User Guide.

The following table shows the files decompressed from the package.

Name Description
app\ Android project code
gradle\ Gradle files

build.gradle

gradle.properties

settings.gradle

Gradle configuration files

gradlew

gradlew.bat

Gradle Wrapper scripts

Opening a Project

Step 1 Start the Android Studio and choose File > Open.

Select the directory where the SDK is decompressed.

Step 2 View the directory structure of the project shown in the following figure.
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Figure 3-33 Project directory structure

h app
b manifests
v java
hd com.testappsignature
£ MainActivity
> com.test.appsignature (androidTest)
» com.test.appsignature (test)
w res
> drawable
W layout
5 Activity_main.xml
» mipmap
3 values

w (# Gradle Scripts

# build.gradle (Project: android)

# build.gradle (Module: app)
gradle.properties (Global Properties)
gradle-wrapper.properties (Gradle Version)

£ proguard-rules.pro (ProGuard Rules for app)
gradle.properties (Project Properties)

#) settings.gradle (Project Settings)

Oyl

local properties (SO Location)

--—-End

API Calling Example

Step 1

Step 2

Step 3

Add required JAR files to the app/libs directory of the Android project. The
following JAR files must be included:

e java-sdk-core-x.x.x.jar
e joda-time-2.10.jar

Add dependencies of the okhttp library to the build.gradle file.

Add implementation 'com.squareup.okhttp3:0khttp:3.14.2' in the dependencies
field of the build.gradle file.

dependencies {

implementation 'com.squareup.okhttp3:okhttp:3.14.3'
}

Create a request, enter an AppKey and AppSecret, and specify the domain name,
method, request URI, and body.

Request request = new Request();

try {
request.setKey ("4f5f626b-073f-402f-a1e0-e52171c6100c");
request.setSecrect("******");
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Step 4

3.12 curl

Scenarios

Prerequisites

request.setMethod ("POST");
request.setUrl("https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1");
request.addQueryStringParam("name", "value");
request.addHeader("Content-Type", "text/plain");
request.setBody("demo");
} catch (Exception e) {
e.printStackTrace();
return;

}

Sign the request to generate an okhttp3.Request object for API access.

okhttp3.Request signedRequest = Client.signOkhttp(request);
OkHttpClient client = new OkHttpClient.Builder().build();
Response response = client.newCall(signedRequest).execute();

--—-End

To use the curl command to call an API through App authentication, download the
JavaScript SDK to generate the curl command, and copy the command to the CLI
to call the API.

You have obtained the domain name, request URL, and request method of the API
to be called, and the AppKey and AppSecret of the app for calling the API. For
more information, see Preparation.

API Calling Example

Step 1

Use the JavaScript SDK to generate the curl command.

Log in to the APl Gateway console, choose API Calling > SDKs in the navigation
pane, and then download the SDK.

Open demo.html in a browser. The following figure shows the demo page.
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Apigateway Signature Test

Key

071fe245-9cf6-4d75-822d-c29945a1e06a

Secret
Method Url

GET = 30030113-3657-4fb6-a7ef-90764239b038.apigw.cn-north-1.huaweicloud.cor
Headers

{"Content-Type":"application/json"}
Body

r3

curl -X GET "http://30030113-3657-4fb6-a7ef-90764239b038.apigw.cn-north-1.huaweiclou
d.com/” -H "X-Sdk-Date: 20190731T065514Z" -H "host: 30030113-3657-4fb6-a7ef-9076423

Note: accessing the APl from browser reguires support for CORS
200
Congratulations, sdk demo is running

Step 2 Specify the key, secret, method, protocol, domain name, and URL. For example:

Key=4f5f626b-073f-402f-a1e0-e52171c6100c

Secret=ririrk

Method=POST
Url=https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com

Step 3 Specify query and header parameters in JSON format, and set the request body.

Step 4 Click Send request to generate a curl command. Copy the curl command to the
CLI to access the API.

$ curl -X POST "https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/" -H "X-Sdk-
Date: 20180530T115847Z" -H "Authorization: SDK-HMAC-SHA256 Access=071fe245-9cf6-4d75-822d-
€29945a1e06a, SignedHeaders=host;x-sdk-date, Signature=9e5314bd156d517******dd3e5765fdde4" -d ""
Congratulations, sdk demo is running

(11 NOTE

The curl command generated using an SDK does not meet the format requirements of
Windows. Please run the curl command in Git Bash.

----End
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Calling APIs Through IAM
Authentication

Token Authentication

AK/SK Authentication

4.1 Token Authentication

Scenarios

To call APIs using a token, add the token to the X-Auth-Token header in API
requests.

(11 NOTE

You can use either of the following authentication methods to call APIs:
e Token authentication: Requests are authenticated using a token.

e AK/SK authentication: Requests are encrypted using an access key ID (AK) and a secret
access key (SK).

Calling an API Through Token Authentication

1. Obtain a token. For details, see chapter "Obtaining a User Token" in the
Identity and Access Management APl Reference. After the request is
processed, the value of X-Subject-Token in the message header is the token
value.

The following figures show how to obtain a token using an API testing tool.
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Example

2.

Figure 4-1 Example request

POST htrpsi/{iam e——. com/v3/auth/tokens Params Send v Save
Body @ Generate Code
form-data x-www-form-urlencoded ® raw binary  Text

2 "auth": {

3 "identity”: {
4 "methods": [
"password"”

.
"password”: {

4 b
s
"scope": {
"project": {

P R e e e
R SN R VI N =T R T

& @ o

"id": "1330 L f0d2568efabc33”

f/this is a example.

Figure 4-2 Obtaining the X-Subject-Token response header

Body Headers (13)

connection —  keep-aliv:

content-type — application/json

date -~ Mon, 05 Nov 2018 09:55:38 GM
server — Web Server

strict-transport-security -  max-age=31536000; include

transfer-encoding — chunked

via — proxy A
x-content-type-options — nosniff
x-download-options — noopen

x-frame-options — SAMN

x-iam-trace-id — 86

L
[
1
)
[

Status: 201 Created  Time: 1010 ms

x-subject-token

— AYIKoZTh

E2G

ZkWYIg+hTHLsTYa5Xcslr

be+VixDYhQF1t)8yaqxVSAyBOPNVA

Call a service APl and add the X-Auth-Token request header to specify the

token obtained in 1.

This section describes the basic procedure for using an API.

1.

Obtain the required information.

Obtain the IAM endpoint from Regions and Endpoints.

On the management console, click the username in the upper right corner,
choose My Credentials from the drop-down list, and then view the project ID

on the displayed page.
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3. Call the token authentication API to obtain a token, and set an environment
variable to pass the token. This token will be used for authentication of other
APIs. For details, see chapter "Obtaining a User Token".

a. Run the following commands to obtain a token:
curl -X POST https://{iam_endpoint}/v3/auth/tokens -H 'content-type: application/json' -d '{
"auth": {
"identity": {
"methods": [
"password"
]

n

:
password": {
"user": {
"name": "{user_ name}’,
"domain": {

b

"password": "{password}'

}
}

n

scope": {
"project™: {
"id": "{project_id}"

}

}
} -vk

Modify the following parameters by referring to /dentity and Access
Management AP/l Reference:

= fiam_endpoint} Replace this parameter with the IAM endpoint.
" {project id} Replace this parameter with the project ID.

" {user name}and {password} Replace these two parameters
respectively with the username and password of the IAM server.

The value of the X-Subject-Token response header is the token.
X-Subject-Token:MIIDkgYJKoZIhveNAQcCollIDgzCCAxxxxxx38CAQEXDTALBglghkgBZQMEAgEwg

b. Run the following command to set an environment variable for passing
the token:

export Token={X-Subject-Token}

X-Subject-Token is the token obtained in 3.a. Example:
export Token=MIIDkgYJKoZIhvcNAQcColIDgzCCAxxxxxx38 CAQEXDTALBglghkgBZQMEAgEwg

4. Call an API. Configure required parameters, and obtain the domain name,

request method, and URL by referring to Preparation.
curl -X Request_method Domain name+URL -H "x-auth-token: $Token" -vk

4.2 AK/SK Authentication

This section describes how to use AK and SK to sign requests.

(1 NOTE

e AK: access key ID, which is a unique identifier used in conjunction with a secret access
key to sign requests cryptographically.

e SK: secret access key used in conjunction with an AK to sign requests cryptographically.
It identifies a request sender and prevents the request from being modified.
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Generating an AK and SK Pair

If an AK/SK pair has already been generated, skip this step. Find the downloaded
AK/SK file, which is usually named credentials.csv.

As shown in the following figure, the file contains the username, access key ID,
and secret access key.

Figure 4-3 Content of the credential.csv file

4 E C
1 |User Name Acceszs Key Id Secret Access Eey
2 EIEEL N GRS RETEATINIVERC | zul TTECORDNT TE AR v aEbhSzsdaGw 4

Perform the following procedure to generate an AK/SK pair:

Register an account and log in to the management console.

Click the username and choose My Credentials from the drop-down list.
Click the Access Keys tab.

Click Create Access Key.

ok N =

Enter the verification code or login password as prompted, and click OK to
download the access key. Keep the access key secure.

Generating a Signature

Generate a signature in the same way as in App authentication mode. Replace
AppKey with AK and replace AppSecret with SK to complete the signing and
request processing. You can sign requests to access APIs by using Java, Go,
Python, C#, JavaScript, PHP, C++, C, and Android.

NOTICE

The local time on the client must be synchronized with the clock server to avoid a
large error in the value of the X-Sdk-Date request header.

API Gateway (APl Management) checks the time format and compares the time
with the time when API Gateway (APl Management) receives the request. If the
time difference exceeds 15 minutes, APl Gateway will reject the request.
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Creating a Function for Frontend
Custom Authentication

Scenarios

API requests can be authenticated using a custom authorizer. You need to create a
FunctionGraph function for frontend custom authentication and define the
required authentication information in the function. The function then serves as a
custom authentication backend to authenticate requests for the API.

Custom authentication is supported for both frontend and backend requests. For
frontend custom authentication, APl Gateway uses a function to authenticate
received API requests. For backend custom authentication, the backend service
invokes another function to authenticate the API requests forwarded by API
Gateway.

This section describes how to encapsulate a function into a "custom authorizer"
and the important operations that need to be noted.

Figure 5-1 Schematic diagram of frontend custom authentication

AR Gatewray Eackend Services
' ’—i—‘ Requests Frontend reguests
@ -
[
Security authentication ECS
Lsers/Apps :
Custom
] 403

App

Internet

The following figure shows the process of calling APIs using custom
authentication.
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Figure 5-2 Calling APIs by using custom authentication

Start
Procedurs Create a function.
Create a function to use it as Create a function in N
the backend for custom FunctionGraph —— =

authentication.

Test the function.

Create a custom authorizer with
the FunctionGraph function.

Set the Custom authentication
mode to authenticate requests

far the AP
Fublish the AFI.
Call the API.
End
{1 NOTE

FunctionGraph is required for custom authorizers. If FunctionGraph is unavailable in the
selected region, custom authorizers are not supported.

Procedure

Step 1 Create a function in FunctionGraph.

The function code must meet the following requirements (Python 2.7 is used as an
example):

e The function code has defined three types of request parameters in the
following formats:

- Header parameters: event["headers"][" Parameter name"]
- Query parameters: event["queryStringParameters"][" Parameter name"]
- Custom user data: event["user_data"]

e The three types of request parameters obtained by the function are mapped
to the custom authentication parameters defined in APl Gateway.

- Header parameter: Corresponds to the identity source specified in Header
for custom authentication. The parameter value is transferred when the
API that uses custom authentication is called.

- Query parameter: Corresponds to the identity source specified in Query
for custom authentication. The parameter value is transferred when the
API that uses custom authentication is called.
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- Custom user data: Corresponds to the user data for custom
authentication. The parameter value is specified when the custom
authentication system is created.

The response of the function cannot be greater than 1 MB and must be
displayed in the following format:

"statusCode":200,
"body": "{\"status\": \"allow\", \"context\": {\"user\": \"abc\"}}"

The body field is a character string, which is JSON-decoded as follows:
{

The status field is mandatory and is used to identify the authentication result.
The authentication result can only be allow or deny. allow indicates that the
authentication is successful, and deny indicates that the authentication fails.

The context field is optional and can only be key-value pairs. The key value
cannot be a JSON object or an array.

The context field contains custom user data. After successful authentication,
the user data is mapped to the backend parameters. The parameter name in
context is case-sensitive and must be the same as the system parameter
name. The parameter name must start with a letter and can contain 1 to 32
characters, including letters, digits, hyphens (-), and underscores (_). After
successful frontend authentication, the value abc of user in context is
mapped to the test parameter in the Header location of backend requests.

Example header parameters:

-*- coding:utf-8 -*-
import json
def handler(event, context):
if event["headers"].get("test")=="abc":
resp = {
'statusCode": 200,
'body": json.dumps({
"status":"allow",
"context":{
"user":"abcd"
}
bl
}
else:
resp = {
'statusCode": 200,
'body": json.dumps({
"status":"deny",
bl
}

return json.dumps(resp)

Example query parameters:

-*- coding:utf-8 -*-
import json
def handler(event, context):

if event["queryStringParameters"].get("test")=="abc"

resp = {
'statusCode": 200,
'body": json.dumps({
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"status":"allow",
"context":{
"user":"abcd"
}
b
}
else:
resp = {
'statusCode': 200,
'body": json.dumps({
"status":"deny",
b
}

return json.dumps(resp)

Example user data:

# -*- coding:utf-8 -*-
import json
def handler(event, context):

if event.get("user_data")=="'abc"

resp = {
'statusCode": 200,
'body": json.dumps({
"status":"allow",
"context":{
"user":"abcd"
}
bl
}
else:
resp = {
'statusCode": 200,
'body": json.dumps({
"status":"deny",
b
}

return json.dumps(resp)

Step 2 Test the function. In the Configure Test Event dialog box, select apig-event-
template, edit the test event, and click Save. Then click Test.

If the execution result is Success, the test is successful.

Next, you need to go to the APl Gateway console to create a frontend custom

authorizer.

--—-End

Follow-Up Operations

for frontend authentication on the API Gateway console.
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Creating a Function for Backend Custom
Authentication

Scenarios

To protect backend services, you can use multiple external authentication systems
by configuring one authentication mechanism. You need to create a
FunctionGraph function for backend custom authentication and define the
required authentication information in the function. The function then serves as a
custom authentication backend to authenticate requests forwarded by API
Gateway.

Figure 6-1 Schematic diagram of backend custom authentication

AP Gateway Backend Services

ﬂ E Requests
UsersiApps Backend authentication @

] Custom

Signature key

2

[nternet

The following figure shows the process of calling APIs using custom
authentication.
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Procedure

Figure 6-2 Calling APIs by using custom authentication

Start

Procedure Create a function.

Create a function to use it as Create a function in I~ e

the backend for custom . =
-1~
authentication. FunctionGraph. 1

Test the function.

Create a custom authorizer with

the FunctionGraph function. Create a custom authorizer.

Set the Custom authentication Create an AP| and specify the

mode to authenticate requests P
for the APl Custom authentication mode.

Debug the AP

Publish the API.

Call the API.

(10 NOTE

FunctionGraph is required for custom authorizers. If FunctionGraph is unavailable in the
selected region, custom authorizers are not supported.

Step 1 Create a function in FunctionGraph.

The function code must meet the following requirements (Python 2.7 is used as an
example):

e The custom user data contained in the function code must be in the following
format: event["user_data"].

e The custom user data corresponds to the user data defined for the custom
authorizer. You can define the user data in any format.

e The response of the function cannot be greater than 1 MB and must be
displayed in the following format:

"statusCode":200,
"body": "{\"status\": \"allow\", \"context\": {\"user\": \"abc\"}}"

The body field is a character string, which is JSON-decoded as follows:
{

"status": "allow/deny",
"context": {

"user": "abc"
}

}
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Step 2

The status field is mandatory and is used to identify the authentication result.
The authentication result can only be allow or deny. allow indicates that the
authentication is successful, and deny indicates that the authentication fails.

The context field is optional and can only be key-value pairs. The key value
cannot be a JSON object or an array.

The context field contains custom user data. After successful authentication,
the user data is mapped to the backend parameters. The parameter name in
context is case-sensitive and must be the same as the system parameter
name. The parameter name in context must start with a letter and contain 1
to 32 characters, including uppercase letters, lowercase letters, digits,
underscores (_), and hyphens (-).

After successful backend authentication, the value abc of user in context is
mapped to the test parameter in the Header location of backend requests
and passed to the backend service.

Example user data:

# -*- coding:utf-8 -*-
import json
import base64
def handler(event, context):
token=base64.b64encode(event["user_data"])
resp = {
'statusCode': 200,
'body": json.dumps({
"status":"allow",
"context":{
"token":token
}
b
}

return json.dumps(resp)

Test the function. In the Configure Test Event dialog box, select blank-template,
and set the following test event:

Click Save. Then click Test.
If the execution result is Success, the test is successful.

Next, you need to go to the APl Gateway console to create a backend custom
authorizer.

--—-End

Follow-Up Operations

for backend authentication on the APl Gateway console.
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Creating Signatures for Backend
Requests

Java
Python
C#

7.1 Java

Scenarios
To use Java to sign backend requests, obtain the Java SDK, import the project, and
verify the backend signature by referring to the example provided in this section.
This section uses IntelliJ IDEA 2018.3.5 as an example.

Prerequisites

e You have obtained the key and secret of the signature key to be used.

e You have created a signature key on the APl Gateway console and bound it to
the API to be called. For more information, see "Creating and Using a
Signature Key" in the User Guide.

e You have downloaded the backend signing sample code.

e You have installed IntelliJ IDEA. If not, download Intelli) IDEA from the official
Intelli) IDEA website and install it.

e You have installed Java Development Kit (JDK) 1.8.111 or a later version. If
not, download JDK from the official Oracle website and install it.

Importing a Project

Step 1 Open Intelli) IDEA, choose File > New > Project from Existing Sources, select the
apigateway-backend-signature-demo\pom.xml file, and click OK.
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Figure 7-1 Select File or Directory to Import

Select File or Directory to Import

Select directory with existing sources,

Eclipse project (.project) or classpath (.classpath] file,

Maven project file (pom.xml),

End/Bndtools workspace (workspace/cnf),
Gradle build script (*.gradle],

Flash Builder project file (.project, *.fxp, *.fxpl).

= x| 5@

GpiGateway-sdki\apigateway-backend-signature-demol\pom.xml| | &
> ApiGateway-android-sdk-1.0.0

v apigateway-backend-signature-demo
> idea
> libs
b src

Step 2 Retain the default settings, click Next for the following four steps, and then click

Finish.

Step 3 On the Maven tab page on the right, double-click compile to compile the file.

Figure 7-2 Compiling the project

Maven 2 —
S kL + m 1 ® T | F

~ |, backend-signature
v g Lifecycle

14 clean
13 validate

2
10 test 1
1 package
14 verify
1% install
¥ site
1% deploy
» [I5Plugins

» [jiDependencies

aseqeleq ([}

UCREPIEA UERR 5 | uaARp 3 | MBIAIDS
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If the message "BUILD SUCCESS" is displayed, the compilation is successful.

Run: backend-signature [compile]
[ [IVFo]
[IVFO] --- maven-resources-plugin:3. 1. 0iresowrces (default-resources) @ backend-signature ——-

[INFO] Using ' UTF-8' encoding to copy filtered resources.
[IVFO] Cepying 1 resource

I 4l

[INFO] Copying O resource

[IVFO]

[IWFO] --- maven-compiler-plugin:3 8.0 compile (default-compile) @ backend-signature ——-
[INFO] Nothing to compile — all classes ars up to date

[I1FO]
[I1F0]
[INFO] Tetal time: 2.688 s

)’ [IVFO] Finished at: 2019-03-11T18:41:09408:00
[IWFO] Final Memory: Z21M/309M

[I1F0]

Process finished with exit code O

Step 4 Right-click BackendSignatureApplication and choose Run.

Figure 7-3 Running the BackendSignatureApplication service

v [ apigateway-backend-signature-demo 1 packa
> idea - .
> [ libs L :
W src 3 Cut Ctrl+X
w main B Copy Cirl+C
v java Copy Path Ctrl+Shift+C
v com.huawei.apigat Copy Reference Ctrl+Alt+Shift+C
€ ApigatewaySigr [ Paste Ctrl+V
& BackendSignat # Jump to Source F4
i HelloCantroller Find Usages Alt+F7
£ RequestWrapp: Analyze ']
> resources Refactor 3
> target Clean Python Compiled Files
pom.xml Add to Favorites ;
» |l External Libraries
Browse Type Hierarchy Ctrl+H
» U Scratches and Consoles
Reformat Code Ctrl+Alt+L
Optimize Imports Ctrl+Alt+0O
Delete... Delete

Build Module 'apigateway-backend-signature-demo’
Recompile "..urefpplicationjava’ Ctrl+Shift+Fg

Run 'BackendSignatureAppl... Ctrl+Shift+F10
# Debug 'BackendSignatureAppl...

U} Run 'BackendSignatureAppl..' with Coverage
@ Create 'BackendSignaturedppl..."...
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Modify the parameters in sample code ApigatewaySignatureFilter.java as
required. For details about the sample code, see Backend Signature Verification
Example.

----End

Backend Signature Verification Example

Step 1

Step 2

Step 3

Step 4

This example demonstrates how to build a Spring boot-based server as the
backend of an APl and implement a filter to verify the signature of requests sent
from API Gateway (APl Management).

(11 NOTE

Signature information is added to requests sent to access the backend of an API only after
a signature key is bound to the API.

Compile a controller that matches all request paths and methods and set the
return body to Hello World!

// HelloController.java

@RestController
@EnableAutoConfiguration
public class HelloController {

@RequestMapping("/*")
private String index() {
return "Hello World!";
}
}

Compile a filter that matches all request paths and methods, and put the
signature key and secret in a Map.
// ApigatewaySignatureFilter.java

@Component
@WebfFilter(filterName = "ApigatewaySignatureFilter", urlPatterns = "/*")
public class ApigatewaySignatureFilter implements Filter {
private static Map<String, String> secrets = new HashMap<>();
static {
secrets.put("signature_key1", "signature_secret1");
secrets.put("signature_key2", "signature_secret2");

}

@Override
public void init(FilterConfig filterConfig) throws ServletException {
}

@Override
public void doFilter(ServletRequest servletRequest, ServletResponse servletResponse, FilterChain chain) {
//Signature verification code

.
}

To ensure that the body can be read in the filter and controller, wrap the request
and send it to the filter and controller. The doFilter function is used for signature
verification. For the implementation of wrapper classes, see RequestWrapper.java.
RequestWrapper request = new RequestWrapper((HttpServletRequest) servletRequest);

Use a regular expression to parse the Authorization header to obtain signingKey
and signedHeaders.
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Step 5

Step 6

private static final Pattern authorizationPattern = Pattern.compile("SDK-HMAC-SHA256\\s+Access=([A,]+),\

\s?SignedHeaders=([A,]+),\\s?Signature=(\\w+)");

String authorization = request.getHeader("Authorization");

if (authorization == null || authorization.length() == 0) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Authorization not found.");
return;

}

Matcher m = authorizationPattern.matcher(authorization);

if (!m.find()) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Authorization format incorrect.");
return;

}

String signingKey = m.group(1);

String signingSecret = secrets.get(signingKey);

if (signingSecret == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signing key not found.");
return;

}

String[] signedHeaders = m.group(2).split(";");

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find signingSecret based on signingKey. If sighingKey does not exist, the
authentication failed.
String signingSecret = secrets.get(signingKey);
if (signingSecret == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signing key not found.");
return;

}

Create a request, and add the method, URL, query, and signedHeaders headers to

the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

Request apiRequest = new DefaultRequest();
apiRequest.setHttpMethod (HttpMethodName.valueOf(request.getMethod()));
String url = request.getRequestURL().toString();
String queryString = request.getQueryString();
try {
apiRequest.setEndpoint((new URL(url)).toURI());
Map<String, String> parametersmap = new HashMap<>();
if (null != queryString && !"".equals(queryString)) {
String[] parameterarray = queryString.split("&");
for (String p : parameterarray) {
String[] p_split = p.split("=", 2);
String key = p_split[0];
String value = "";
if (p_split.length >=2) {
value = p_split[1];
}

parametersmap.put(URLDecoder.decode(key, "UTF-8"), URLDecoder.decode(value, "UTF-8"));

}

apiRequest.setParameters(parametersmap); //set query

}
} catch (URISyntaxException e) {
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e.printStackTrace();
}

boolean needbody = true;
String dateHeader = null;
for (inti = 0; i < signedHeaders.length; i++) {
String headerValue = request.getHeader(signedHeaders[i]);
if (headerValue == null || headerValue.length() == 0) {
((HttpServletResponse) response).sendError(HttpServletResponse.SC_UNAUTHORIZED, "signed
header" + signedHeaders[i] + " not found.");
} else {
apiRequest.addHeader(signedHeaders[i], headerValue);//set header
if (signedHeaders[i].toLowerCase().equals("x-sdk-content-sha256") &&
headerValue.equals("UNSIGNED-PAYLOAD")) {
needbody = false;

if (signedHeaders[i].toLowerCase().equals("x-sdk-date")) {
dateHeader = headerValue;
}
}
}

if (needbody) {
apiRequest.setContent(new ByteArraylnputStream(request.getBody())); //set body

Step 7 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.

private static final DateTimeFormatter timeFormatter =
DateTimeFormat.forPattern("yyyyMMdd'T'HHmmss'Z'"").withZoneUTC();

if (dateHeader == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Header x-sdk-date not found.");
return;

}

long date = timeFormatter.parseMillis(dateHeader);

long duration = Math.abs(DateTime.now().getMillis() - date);

if (duration > 15 * 60 * 1000) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signature expired.");
return;

}

Step 8 Add the Authorization header to the request, and invoke the verify method to
verify the request signature. If the verification is successful, the next filter is
executed. Otherwise, the authentication failed.

DefaultSigner signer = (DefaultSigner) SignerFactory.getSigner();
boolean verify = signer.verify(apiRequest, new BasicCredentials(signingKey, signingSecret));
if (verify) {
chain.doFilter(request, response);
} else {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "verify authroization failed.");
}

Step 9 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns Hello World!

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.
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Apigateway Signature Test

signature_key1

Secret

signature_secret1

Method Scheme Host Url

POST = http  # | localhost:8080 test
Query

{00 yyy"}

y

Headers

{"aaa" bbb’}
Body

dsfasdf=1

Debug

curl -X POST "http://localhost:8080/testhoo=yyy" -H "aaa: bbb" -H "X-Sdk-Date: 20190307T
122402Z" -H "host: localhost:8080" -H “Authorization: SDK-HMAC-SHA256 Access=signatur X

--—-End

7.2 Python

Scenarios

To use Python to sign backend requests, obtain the Python SDK, import the
project, and verify the backend signature by referring to the example provided in
this section.

This section uses IntelliJ IDEA 2018.3.5 as an example.

Preparing the Environment
e You have obtained the key and secret of the signature key to be used.

e You have created a signature key on the APl Gateway console and bound it to
the API to be called. For more information, see "Creating and Using a
Signature Key" in the User Guide.

e Log in to the API Gateway console, and download the SDK on the SDKs page
by referring to section "SDKs" in the User Guide.

e You have installed Python 2.7 or 3.X. If not, download the Python installation
package from the official Python website and install it.

e You have installed Intelli) IDEA. If not, download Intelli) IDEA from the official
Intelli) IDEA website and install it.
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e You have installed the Python plug-in on Intelli) IDEA. If not, install the
Python plug-in according to Figure 7-4.

Figure 7-4 Installing the Python plug-in

Settings @
Qr Plugins 2 Installed Updates n
» Appearance & Behavior
o] 3
B Search Results (41)
[ ewgine [ MicroPython
* Version Control Languages Framework integration
» Build, Execution, Deployment The Python plug-in provides Support for MicroPython
> Languages & Frameworks smart editing for Python devices in Intelli) IDEA and
scripts. The feature set of the... PyCharm. Features: Code...
RECSE @ " 26,2019 4 25M 3.9 o 12,2019 4 337K 4.9
Live Coding in Python python-typing-adder
Code tools Code toals
Lets you run your Python README Using intelljj to infer
code as you type it. Displays Python typing and add type
variable values, matplotlib, or.. comments using the typing...
& 14, 2018 £ 157K &) 14, 2017 4 214K 2
Install
o
Importing a Project
Step 1 Start Intelli) IDEA and choose File > New > Project.
On the displayed New Project page, choose Python and click Next.
Figure 7-5 New Python
New Project [l
Maven Project SDK: | @ Python 3.7.2 (D:\ §® python.exe) ~ New...
Gradle Additional Libraries and Framewarks:
G Groovy LN Djange
Grails 1€ Google App Engine (Python)
Application Forge [ 2o SQL Support
o Go
“ Go Modules (vgo)
% Dep
‘s App Engine
Static Web
£ Flash Template language:
Templates folder: templates
Application name:
K Kotlin =
Enable Django admin
& Empty Project 2
Cancel Help
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Step 2 Click Next. Click ..., select the directory where the SDK is decompressed, and click

Finish.

Figure 7-6 Selecting the SDK directory of Python after decompression

Mew Praoject

Project name: | p)-'thcunl

Project location: | D¥\java',python

P More Settings

Previous Cancel

Step 3 View the directory structure shown in the following figure.

Figure 7-7 Directory structure

b python
> idea !
> apig_sdk
» licenses

.+ backend signature.py
= main.py

m Python.iml
- test_signer.py

= VERSION
¥ |l External Libraries

» UgpScratches and Consoles
Step 4 Click Edit Configurations.

Figure 7-8 Edit Configurations

o
232

— Edit Configurations...

Help
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Step 5 Click + and choose Flask server.

Figure 7-9 Choosing Flask server

Run/Debug Configurations

I Cucumber java

Add New Configuration

vy Docker 2
& Firefox Remote

% Go App Engine
"L Go Build

._.1 Go Remote
‘v Go Test

Step 6 Set Target type to Script path, select backend_signature.py from the Target

drop-down list box, and click OK.

[ share [ Allow parallel run

() Module name @ Script path () Custom

‘\pythoen\backend_signature.py

Ll

+ — B F | Name:  Flask (backend_signature.py)
~ {_Flask server S S L
Flask (backend_signature.py) IR =i
= PY. —
> Templates Target type:
Target:
Application:

Additional options:

FLASK_ENV:

FLASK_DEBUG: |

¥ Environment

Environment variables:

Pythan Interpreter:

Interpreter options:

Working directory:

development

(0 Use SDK of madule:

(®) Use specified interpreter: Python 3.7 =

[ Add content roots to PYTHONPATH
[ Add source roots to PYTHONPATH

--—-End

Backend Signature Verification Example

Cancel Apply

This example demonstrates how to build a Flask-based server as the backend of
an APl and implement a wrapper to verify the signature of requests sent from API

Gateway (APl Management).

(11 NOTE

Signature information is added to requests sent to access the backend of an API only after

a signature key is bound to the API.
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Step 1

Step 2

Step 3

Step 4

Step 5

Compile an interface that returns Hello World! Configure the GET, POST, PUT, and
DELETE methods and the requires_apigateway_signature wrapper.
app = Flask(__name_)

@app.route("/<id>", methods=['GET', 'POST", 'PUT', 'DELETE'])
@requires_apigateway_signature()
def hello(id):

return "Hello World!"

Implement requires_apigateway_signature by putting the signature key and
secret in a dict.

def requires_apigateway_signature():
def wrapper(f):

secrets = {
"signature_key1": "signature_secret1",
"signature_key2": "signature_secret2",
}
authorizationPattern = re.compile(
r'SDK-HMAC-SHA256\s+Access=([A,]+),\s?SignedHeaders=([A,]+),\s?Signature=(\w+)")
BasicDateFormat = "%Y%m%dT%H%M%SZ"

@wraps(f)
def wrapped(*args, **kwargs):
//Signature verification code

return f(*args, **kwargs)
return wrapped
return wrapper

Use a regular expression to parse the Authorization header. The key and
signedHeaders are obtained. The wrapped function is used for signature
verification.

if "authorization" not in request.headers:

return 'Authorization not found.', 401
authorization = request.headers['authorization']
m = authorizationPattern.match(authorization)
if m is None:

return 'Authorization format incorrect.', 401
signingKey = m.group(1)
signedHeaders = m.group(2).split(";")

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find secret based on key. If key does not exist, the authentication failed.

if signingKey not in secrets:
return 'Signing key not found.', 401
signingSecret = secrets[signingKey]

Create an HttpRequest, and add the method, URL, query, and signedHeaders
headers to the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

r = signer.HttpRequest()
rmethod = request.method
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ruri = request.path
rquery = {}
for k in request.query_string.decode('utf-8').split('&'"):
spl = k.split("=", 1)
if len(spl) < 2:
rquery[spl[0]] = ""
else:
rquery[spl[0]] = spl[1]
r.headers = {}
needbody = True
dateHeader = None
for k in signedHeaders:
if k not in request.headers:
return 'Signed header ' + k + ' not found', 401
v = request.headers[k]
if k.lower() == 'x-sdk-content-sha256' and v == 'UNSIGNED-PAYLOAD"
needbody = False
if k.lower() == 'x-sdk-date"
dateHeader = v
r.headers[k] = v
if needbody:
rbody = request.get_data()

Step 6 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.

if dateHeader is None:
return 'Header x-sdk-date not found.', 401

t = datetime.strptime(dateHeader, BasicDateFormat)

if abs(t - datetime.utcnow()) > timedelta(minutes=15):
return 'Signature expired.', 401

Step 7 Invoke the verify method to verify the signature of the request, and check
whether the verification is successful.

sig = signer.Signer()
sig.Key = signingKey
sig.Secret = signingSecret
if not sig.Verify(r, m.group(3)):
return 'Verify authroization failed.', 401

Step 8 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns 200.

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.

2021-10-25 69



API Gateway
Developer Guide 7 Creating Signatures for Backend Requests

Apigateway Signature Test

signature_key1

Secret

sig\mtw e_secret]

Method Scheme Host Url

POST = http # localhost:8080 test

Query

{"00¢"+"yyy")

Headers

{"aaa":"bbb"}

Body

dsfasdf=1

curl -X POST "http://localhost:8080/testPxxx=yyy" -H "aaa: bbb" -H "X-5dk-Date: 20190307T
1224027" -H "host: localhost:8080" -H "Authorization: SDK-HMAC-SHA256 Access=signatur

----End

7.3 C#

Scenarios

To use C# to sign backend requests, obtain the C# SDK, import the project, and
verify the backend signature by referring to the example provided in this section.

Preparing the Environment
e You have obtained the key and secret of the signature key to be used.

e You have created a signature key on the APl Gateway console and bound it to
the API to be called. For more information, see "Creating and Using a
Signature Key" in the User Guide.

e Log in to the API Gateway console, and download the SDK on the SDKs page
by referring to section "SDKs" in the User Guide.

e You have installed Visual Studio. If not, download it from the Visual Studio
official website and install it.

Opening a Project

Double-click csharp.sln in the SDK package to open the project. The project
contains the following:
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e apigateway-signature: Shared library that implements the signature
algorithm. It can be used in the .Net Framework and .Net Core projects.

e backend-signature: Example of a backend signature. Modify the parameters
as required. For details about the sample code, see Backend Signature
Verification Example.

o sdk-request: Example of invoking the signature algorithm.

Backend Signature Verification Example

Step 1

This example demonstrates how to build an ASP.Net Core-based server as the
backend of an APl and implement an lAuthorizationFilter to verify the signature of
requests sent from APl Gateway (APl Management).

(11 NOTE

Signature information is added to requests sent to access the backend of an API only after
a signature key is bound to the API.

Write a controller that provides the GET, POST, PUT, and DELETE interfaces, and
add the ApigatewaySignatureFilter attribute.

// ValuesController.cs

namespace backend_signature.Controllers
{
[Route("api/[controller]")]
[ApiController]
[ApigatewaySignatureFilter]
public class ValuesController : ControllerBase
{
// GET api/values
[HttpGet]
public ActionResult<IEnumerable<string>> Get()
{
return new string[] { "value1", "value2" };

}

// POST api/values

[HttpPost]

public void Post([FromBody] string value)
{

}

// PUT api/values/5

[HttpPut("{id}")]

public void Put(int id, [FromBody] string value)
{

}

// DELETE api/values/5
[HttpDelete("{id}")]
public void Delete(int id)
{
}
}
}

Step 2 Implement ApigatewaySignatureFilter by putting the signature key and secret in

a Dictionary.
// ApigatewaySignatureFilter.cs

namespace backend_signature.Filters

public class ApigatewaySignatureFilter : Attribute, IAuthorizationFilter
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Step 3

Step 4

Step 5

{
private Dictionary<string, string> secrets = new Dictionary<string, string>
{
{"signature_key1", "signature_secret1" },
{"signature_key2", "signature_secret2" },
b

public void OnAuthorization(AuthorizationFilterContext context) {
//Signature verification code

)
}
}

Use a regular expression to parse the Authorization header. The key and
signedHeaders are obtained. The OnAuthorization function is used for signature
verification.

private Regex authorizationPattern = new Regex("SDK-HMAC-SHA256\\s+Access=([A,]+),\\s?
SignedHeaders=([A,1+),\\s?Signature=(\\w+)");

string authorization = request.Headers["Authorization"];
if (authorization == null)
{
context.Result = new UnauthorizedResult();
return;
}
var matches = authorizationPattern.Matches(authorization);
if (matches.Count == 0)
{
context.Result = new UnauthorizedResult();
return;
}
var groups = matches[0].Groups;
string key = groups[1].Value;
string[] signedHeaders = groups[2].Value.Split(';");

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find secret based on key. If key does not exist, the authentication failed.

if (!secrets.ContainsKey(key))

{
context.Result = new UnauthorizedResult();
return;

}

string secret = secrets[key];

Create an HttpRequest, and add the method, URL, query, and signedHeaders
headers to the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

HttpRequest sdkRequest = new HttpRequest();
sdkRequest.method = request.Method;

sdkRequest.host = request.Host.Value;

sdkRequest.uri = request.Path;

Dictionary<string, string> query = new Dictionary<string, string>();
foreach (var pair in request.Query)
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{
query[pair.Key] = pair.Value;

sdkRequest.query = query;

WebHeaderCollection headers = new WebHeaderCollection();
string dateHeader = null;

bool needBody = true;

foreach (var h in signedHeaders)

{
var value = request.Headers[h];
headers[h] = value;
if (h.ToLower() == "x-sdk-date")

dateHeader = value;
}
if (h.ToLower() == "x-sdk-content-sha256" && value == "UNSIGNED-PAYLOAD")

needBody = false;

}

sdkRequest.headers = headers;
if (needBody)
{

request.EnableRewind();
using (MemoryStream ms = new MemoryStream())

{
request.Body.CopyTo(ms);
sdkRequest.body = Encoding.UTF8.GetString(ms.ToArray());

}

request.Body.Position = 0;

}

Step 6 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.
private const string BasicDateFormat = "yyyyMMddTHHmMmssZ";

if(dateHeader == null)
{

context.Result = new UnauthorizedResult();
return;

}
DateTime t = DateTime.ParseExact(dateHeader, BasicDateFormat, Culturelnfo.CurrentCulture);
if (Math.Abs((t - DateTime.Now).Minutes) > 15)

context.Result = new UnauthorizedResult();
return;

}

Step 7 Invoke the verify method to verify the signature of the request, and check
whether the verification is successful.
Signer signer = new Signer();
signer.Key = key;
signer.Secret = secret;

if (!signer.Verify(sdkRequest, groups[3].Value))
{

context.Result = new UnauthorizedResult();

}

Step 8 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.
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Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the

server returns 200.

If an incorrect key or secret is used, the server returns 401, which means

authentication failure.

Apigateway Signature Test

Key

Secret

signature_secret1

Method Scheme Host

POST # http  # localhost:8080

Query

{300 yyy"}

Headers

Body

dsfasdf=1

Debug

url

[test

£

curl -X POST "http://localhost:8080/testTx=yyy" -H "aaa: bbb" -H "X-Sdk-Date: 201903077
122402Z" -H "host: localhost:8080" -H "Authorization: SDK-HMAC-SHA256 Access=signatur

--—-End
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Importing and Exporting APIs

Restrictions and Compatibility
Importing APIs

Exporting APIs

Extended Definition

Examples of Importing APIs

8.1 Restrictions and Compatibility

Note the following restrictions and compatibility issues when importing or
exporting APIs on APl Gateway:

e  Only Swagger 2.0 is supported.

e The request parameter types in Swagger 2.0 differ from those on API
Gateway. See the following table.

Table 8-1 Differences in request parameter types

Swagger Parameter APl Gateway Supported Attribute
Type Parameter Type
integer number maximum
long minimum
float default
double enum
required
description
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Swagger Parameter APl Gateway Supported Attribute
Type Parameter Type
string string maxLength
minLength
default
enum
required
description
Others - -

e APl Gateway does not support the configuration of request parameters in the
formData and body locations.

e The names of header parameters are not case-sensitive.

e APl Gateway does not support the configuration of parameters consumes and
produces.

e Imported and exported Swagger objects are mapped to APl Gateway objects,
as shown in the following table.

Swagger API Import Export
Object Gateway
Object
info.title API group Importing to a new | API group name
name API group: a new API
group name

Importing to an
existing API group:
not used

An API group name
consists of 3-64
characters, starting
with a letter. Only
letters, digits, and
underscores (_) are

allowed.
info.descript | APl group Importing to a new API group
ion name API group: a new API | description
group name

Importing to an
existing APl group:
not used
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Swagger API Import Export
Object Gateway
Object
info.version | APl group Not used User-defined API
name group name
The current time is
used as the API
group name if no
name is specified.
host - Not used The first user-
defined domain
name of an API
group is
preferentially used.
The independent
domain name of the
API group is used if
the API group is not
bound with any
user-defined domain
names.
basePath - Merged with the Not used
request path of each
API
paths.path API request Merged with API request path
path basePath to use as
an API request path
operation.op | APl name APl name APl name
erationld
operation.de | API API description API description
scription description

operation.pa
rameters

API frontend
request
parameters

API request
parameters

API request
parameters

operation.sc

API frontend

API request protocol

API request protocol

hemes request

protocol
operation.re | - Not used Default response
sponses
operation.se | API APl authentication API authentication
curity authenticatio | mode mode

n mode

Used together with
x-apigateway-auth-
type

Used together with
x-apigateway-auth-
type

2021-10-25

77



https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#info-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#swagger-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#swagger-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#paths-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object
https://github.com/OAI/OpenAPI-Specification/blob/master/versions/2.0.md#operation-object

API Gateway
Developer Guide 8 Importing and Exporting APIs

e APl request paths differ between Swagger and APl Gateway. See the following

table.

Syntax Swagger APl Gateway

/users/{userName} Supported Supported

Jusers/prefix-{userName} Supported Not supported for

Jusers/{userName}-suffix Erofptgtpd request

efinition

/users/prefix-{userName} -

suffix Supported for
backend request
definition

Jusers/{proxy+} Not supported Supported for
frontend request
definition
Not supported for
backend request
definition

e APl Gateway supports the following extended fields when importing APIs:
- x-apigateway-auth-type
- x-apigateway-request-type
-  x-apigateway-match-mode
-  Xx-apigateway-cors
- x-apigateway-any-method
-  x-apigateway-backend
®  x-apigateway-backend.parameters
®  x-apigateway-backend.httpEndpoints
®  x-apigateway-backend.httpVpcEndpoints

®  x-apigateway-backend.functionEndpoints

®  x-apigateway-backend.mockEndpoints
- x-apigateway-backend-policies

®  x-apigateway-backend-policies.conditions
- x-apigateway-ratelimit
-  x-apigateway-ratelimits

®  x-apigateway-ratelimits.policy

®  x-apigateway-ratelimits.policy.special
- x-apigateway-access-control
-  x-apigateway-access-controls
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®  x-apigateway-access-controls.policy
Backend policy restrictions are as follows:

-  Default backend type HTTP: The HTTP and HTTP-VPC backends are
supported.

-  Default backend type HTTP-VPC: The HTTP and HTTP-VPC backends are
supported.

- Default backend type function: Only the function backend is supported.
-  Default backend type mock: Only the mock backend is supported.

8.2 Importing APIs

Before importing Swagger 2.0 APIs to APl Gateway, you need to supplement
extended definitions of the APIs. For more information, see Extended Definition.

Importing APIs to a New API Group

When you import APIs to a new APl group name, the system creates an API group.

This function is suitable for importing new APIs to APl Gateway.

Before importing APIs, ensure that the following requirements are met:

Your API group and API quotas are sufficient.
The info.title object of Swagger indicates an APl group name.

If two of the APIs you are importing have the same definition, the former API
can be imported successfully and the latter APl cannot be imported.

Imported APIs must be manually published before they are available for
access.

Importing APIs to an Existing API Group

When you import APIs to a specified API group, the system adds them to the API
group while retaining the existing APlIs.

This function is suitable for importing new or modified APIs to an existing API
group.

Before importing APIs, ensure that the following requirements are met:

Your API quota is sufficient.

If the definition of an API you are importing is the same as that of an existing
API, you can overwrite the existing API or retain it. If you leave the existing
API alone, the new API will not be imported.

Imported APIs must be manually published before they are available for
access.

8.3 Exporting APIs

Export APIs from APl Gateway by saving their definitions as Swagger files. You can
export the basic, full, or extended definitions of APlIs.

2021-10-25

79



API Gateway
Developer Guide 8 Importing and Exporting APIs

Exporting the Basic Definition of an API

The basic definition of an API is composed of the request and response definitions
and does not include the backend definition. The request definition includes both
standard and extended Swagger fields.

This function can generate a Swagger API definition file.

Exporting the Full Definition of an API

The full definition of an API is composed of the request, backend, and response
definitions.

This function can be used to back up the full definition of an API as a Swagger
file.

Exporting the Extended Definition of an API

The extended definition of an APl is composed of the request, backend, and
response definitions as well as the request throttling policy, access control policy,
and other configurations of the API.

8.4 Extended Definition

The extended definition of an API includes the API's special configurations on API
Gateway, such as authentication mode and backend parameters.

The extended definition fields of API Gateway are as follows:

1 x-apigateway-auth-type

Meaning: Swagger-based apiKey authentication format, which defines an
authentication mode provided by API Gateway.

Scope of effect: Security Scheme Object

Example:

securityDefinitions:
apig-auth-app:
in: header
name: Authorization
type: apiKey
x-apigateway-auth-type: AppSigv1
apig-auth-iam:
in: header
name: unused
type: apiKey
x-apigateway-auth-type: IAM
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Table 8-2 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Authentication type. Only apiKey is
supported.
name Yes String Name of the parameter for
authentication.
in Yes String Only header is supported.
description No String Description about the authentication.
x-apigateway- | Yes String Authentication mode used on API
auth-type Gateway. AppSigv1 and IAM are
supported.

2 x-apigateway-request-type
Meaning: API request type, which can be public or private.
Scope of effect: Operation Object

Example:

paths:
'/path":
get:
x-apigateway-request-type: 'public'

Table 8-3 Parameter description

Parameter Man | Type Description

dator

y
x-apigateway- | Yes String API visibility. The options include
request-type public and private.

e public: The API can be made
available for sale.

e private: The API will not be
available for sale.

3 x-apigateway-match-mode
Meaning: Request URL matching mode, which can be NORMAL or SWA.
Scope of effect: Operation Object

Example:
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paths:
'/path":
get:
x-apigateway-match-mode: 'SWA'

Table 8-4 Parameter description

Parameter Man | Type Description

dator

y
x-apigateway- | Yes String APl matching mode. The options
match-mode include SWA and NORMAL.

e SWA: prefix match. For example,
both /prefix/foo and /prefix/bar
match /prefix, but /prefixpart does
not match.

o NORMAL: exact match.

4 x-apigateway-cors
Meaning: Specifies whether CORS is supported. The value is of the Boolean type.
Scope of effect: Operation Object

Example:

paths:
'/path":
get:
x-apigateway-cors: true

For the API request for enabling CORS, the headers listed in the following table
will be added to the response.

Header Value Description
Access-Control-Max- 172800 Maximum time the
Age response of a preflight
request can be cached.
Access-Control-Allow- | * Requests from any
Origin domain are allowed.
Access-Control-Allow- | X-Sdk-Date, X-Sdk-Nonce, Headers that can be
Headers X-Proxy-Signed-Headers, X- | used by a formal
Sdk-Content-Sha256, X- request.

Forwarded-For,
Authorization, Content-
Type, Accept, Accept-
Ranges, Cache-Control,
and Range
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Header Value

Description

Methods
PATCH

Access-Control-Allow- | GET, POST, PUT, DELETE,
HEAD, OPTIONS, and

Methods that can be
used by a formal
request.

5 x-apigateway-any-method

Meaning: API request method used by default if no HTTP request method is

specified.
Scope of effect: Path Item Object

Example:

paths:
'/path':
get:
produces:
- application/json
responses:
"'200":
description: "get response"
x-apigateway-any-method:
produces:
- application/json
responses:
"'200":
description: "any response"

6 x-apigateway-backend
Meaning: API backend definition.
Scope of effect: Operation Object

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "backend endpoint type"

Table 8-5 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Backend service type. The options
include HTTP, HTTP-VPC, FUNCTION,
and MOCK.
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Parameter Man | Type Description
dator
y
parameters No X- Backend parameters.
apigateway-
backend.para
meters

httpEndpoints | No X-
apigateway-
backend.http
Endpoints

HTTP backend service definition.

httpVpcEndpo | No X-

ints apigateway-
backend.http
VpcEndpoints

HTTP VPC backend service definition.

functionEndp | No X-

oints apigateway-
backend.func
tionEndpoint

Function backend service definition.

s
mockEndpoint | No X- Mock backend service definition.
s apigateway-

backend.moc

kEndpoints

6.1 x-apigateway-backend.parameters
Meaning: API backend service definition.
Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
parameters:
- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true
- name: "userld"
description: "Username"
type: "string"
in: "path"
required: true
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
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type: "HTTP"
parameters:
- name: "userld"
value: "userld"
in: "query"
origin: "REQUEST"
description: "Username"
- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "Caller"

Table 8-6 Parameter description

Parameter Man | Type Description
dator
y
name Yes String Parameter name, which consists of a
maximum of 32 bytes, starting with a
letter. Only letters, digits, periods (.),
hyphens (-), and underscores (_) are
allowed.
The names of header parameters are
not case-sensitive.
value Yes String Parameter value, which is a parameter
name if the parameter comes from a
request.
in Yes String Parameter location, which can be
header, query, or path.
origin Yes String Parameter mapping source. The
options include REQUEST and
CONSTANT.
description No String Parameter meaning.

6.2 x-apigateway-backend.httpEndpoints

Meaning: HTTP backend service definition.

Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
parameters:
- name: "X-Auth-Token"

description: "Authentication token"

type: "string"
in: "header"
required: true
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responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "HTTP"
httpEndpoints:
address: "example.com"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000

Table 8-7 Parameter description

Parameter Man | Type Description
dator
y
address Yes Array Backend service address. The format is
<Domain name or IP address>:[Port
number]
scheme Yes String Backend request protocol. HTTP and

HTTPS are supported.

method Yes String Backend request method. The options
include GET, POST, PUT, DELETE,
HEAD, OPTIONS, PATCH, and ANY.

path Yes String Backend request path, which can
contain variables.

timeout No Number Backend request timeout in
milliseconds. The range is 1-60,000,
and the default value is 5000.

6.3 x-apigateway-backend.httpVpcEndpoints
Meaning: HTTP VPC backend service definition.
Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
parameters:
- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
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type: "HTTP-VPC"

httpVpcEndpoints:
name: "vpc-test-1"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000

Table 8-8 Parameter description

Parameter Man | Type Description
dator
y
name Yes Array VPC channel name.
scheme Yes String Backend request protocol. HTTP and
HTTPS are supported.
method Yes String Backend request method. The options
include GET, POST, PUT, DELETE,
HEAD, OPTIONS, PATCH, and ANY.
path Yes String Backend request path, which can
contain variables.
timeout No Number Backend request timeout in
milliseconds. The range is 1-60,000,
and the default value is 5000.

6.4 x-apigateway-backend.functionEndpoints

Meaning: Function backend service definition.

Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
parameters:
- name: "X-Auth-Token"

description: "Authentication token"

type: "string"
in: "header"
required: true
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "FUNCTION"
functionEndpoints:
version: "v1"
function-urn: ""
invocation-type: "synchronous"
timeout: 30000
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Table 8-9 Parameter description

Parameter Man | Type Description
dator
y
function-urn Yes String Function URN.
version Yes String Function version.
invocation- Yes String Function invocation type. The value
type can be async or sync.
timeout No Number Function timeout in milliseconds. The

range is 1-60,000, and the default

value is 5000.

6.5 x-apigateway-backend.mockEndpoints
Meaning: Mock backend service definition.
Scope of effect: x-apigateway-backend

Example:

paths:
'fusers/{userld}"
get:
produces:
- "application/json"
parameters:
- name: "X-Auth-Token"
description: "Authentication token"
type: "string"
in: "header"
required: true
responses:
default:
description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "MOCK"
mockEndpoints:
result-content: "mocked"

Table 8-10 Parameter description

Parameter Man | Type Description
dator
y

result-content | Yes String Mock response.

7 x-apigateway-backend-policies

Meaning: API backend policy.
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Scope of effect: Operation Object

Example:

paths:
'/users/{userld}"
get:
produces:

- "application/json"

responses:

default:
description: "default response"

x-apigateway-request-type: "public"
x-apigateway-backend:

type: "backend endpoint type"

x-apigateway-backend-policies:

- type: "backend endpoint type"
name: "backend policy name"
conditions:

- type: "equal/enum/pattern”,
value: "string",
origin: "source/request_parameter",
parameter_name: "string"

Table 8-11 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Backend service type. The options
include HTTP, HTTP-VPC, FUNCTION,
and MOCK.

name Yes String Backend policy name.
parameters No X- Backend parameters.

apigateway-

backend.para

meters
httpEndpoints | No X- HTTP service definition.

apigateway-

backend.http

Endpoints
httpVpcEndpo | No X- HTTP-VPC service definition.
ints apigateway-

backend.http

VpcEndpoints
functionEndp | No X- Function service definition.
oints apigateway-

backend.func

tionEndpoint

s
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7.1 x-apigateway-backend-policies.conditions

Parameter Man | Type Description
dator
y
mockEndpoint | No X- Mock service definition.
s apigateway-
backend.moc
kEndpoints
conditions Yes X- Policy condition array.
apigateway-
backend-

policies.condi
tions

Meaning: API backend policy conditions.

Scope of effect: x-apigateway-backend-policies

Example:

paths:
'fusers/{userld}"
get:
produces:

- "application/json"

responses:
default:

description: "default response"
x-apigateway-request-type: "public"
x-apigateway-backend:
type: "backend endpoint type"
x-apigateway-backend-policies:
- type: "backend endpoint type"
name: "backend policy name"

conditions:

- type: "equal/enum/pattern”,
value: "string",
origin: "source/request_parameter",
parameter_name: "string"

Table 8-12 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Policy condition type. The options
include equal, enum, and pattern.
value Yes String Policy condition value.
origin Yes String Policy condition source. The options

include source and request.
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Parameter Man | Type Description
dator
y
parameter No String Input parameter name if the origin

parameter is set to request.

8 x-apigateway-ratelimit

9 x-apigateway-ratelimits

Meaning: Request throttling policy.

Scope of effect: Operation Object

Example:

paths:
'/path":
get:

x-apigateway-ratelimit: 'customRatelimitName'

Meaning: Mapping between a request throttling policy name and limit values.

Scope of effect: Swagger Object

Example:

x-apigateway-ratelimits:
customRatelimitName:

api-limit: 200
app-limit: 200
user-limit: 200
ip-limit: 200
interval: 1

unit: second/minute/hour

shared: true
special:

- type: APP

limit: 100

instance: XxXxxxXxxx

Table 8-13 Parameter description

Parameter Man | Type Description
dator
y
customRateli | No X- Name of a request throttling policy.
mitName apigateway- | 14 yse a request throttling policy, set
ratelimits.pol | y_apigateway-ratelimit to the name
Icy of the policy.

9.1 x-apigateway-ratelimits.policy

Meaning: Definition of a request throttling policy.
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Scope of effect: x-apigateway-ratelimits

Example:

x-apigateway-ratelimits:
customRatelimitName:
api-limit: 200
app-limit: 200
user-limit: 200
ip-limit: 200
interval: 1
unit: MINUTE
shared: false
special:
- type: USER
limit: 100
instance: XxXxxxxx

Table 8-14 Parameter description

Parameter Man | Type Description
dator
y
api-limit Yes Number Limit of API access.
user-limit No Number Limit of API access for users.
app-limit No Number Limit of API access for apps.
ip-limit No Number Limit of API access for source IP
addresses.
interval Yes Number Throttling period.
unit Yes String Throttling unit, which can be SECOND,
MINUTE, HOUR, or DAY.
shared No Boolean Whether to share the throttling limits
among APIs.
special No X- Special request throttling policy.
apigateway-
ratelimits.pol
icy.special
Array

9.2 x-apigateway-ratelimits.policy.special
Meaning: Definition of a special request throttling policy.
Scope of effect: x-apigateway-ratelimits.policy

Example:

x-apigateway-ratelimits:
customRatelimitName:
api-limit: 200
app-limit: 200
user-limit: 200
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ip-limit: 200
interval: 1
unit: MINUTE
shared: false
special:
- type: USER
limit: 100
instance: XXXXXxXxx

Table 8-15 Parameter description

Parameter Man | Type Description
dator
y
type Yes String Special request throttling policy type,
which can be APP or USER.
limit Yes Number Access limit.
instance Yes String Object ID of an excluded app or user.

10 x-apigateway-access-control
Meaning: Access control policy.
Scope of effect: Operation Object
Example:
paths:
'/path":
get:
x-apigateway-access-control: 'customAccessControlName'

11 x-apigateway-access-controls

Meaning: Mapping between an access control policy name and limit settings.
Scope of effect: Swagger Object

Example:

x-apigateway-access-controls:
customAccessControlName:
acl-type: "DENY"
entity-type: "IP"
value: 127.0.0.1,192.168.0.1/16
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Table 8-16 Parameter description

Parameter Man | Type Description
dator
y
customAccess | No X- Name of an access control policy.
ControlName apigateway- | 14 yse a request throttling policy, set
access- | x-apigateway-access-control to the
controls.polic | hame of the policy.
y

11.1 x-apigateway-access-controls.policy
Meaning: Definition of an access control policy.
Scope of effect: x-apigateway-access-controls

Example:

x-apigateway-access-controls:
customAccessControlName:
acl-type: "DENY"
entity-type: "IP"
value: 127.0.0.1,192.168.0.1/16

Table 8-17 Parameter description

Parameter Man | Type Description
dator
y
acl-type Yes String Access control effect. The options

include PERMIT and DENY.

entity-type Yes String Access control object. Only IP
addresses are supported.

value Yes String Access control values, which are
separated with commas (,).

8.5 Examples of Importing APIs

Importing an HTTP Backend Service API

Import the request parameter definition of an HTTP backend service API that uses
the GET method and is accessed through IAM authentication.

swagger: "2.0"

info:
title: "importHttpEndpoint10"
description: "import apis"
version: "1.0"

host: "api.account.com"
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paths:
'/http/{userld}":

get:
operationld: "getUser3"
description: "get user by userld"
security:
- apig-auth-iam: []
schemes:
- https
parameters:
- name: "test"
description: "authorization token"
type: "string"
in: "header"
required: true
- name: "userld"
description: "user id"
type: "string"
in: "path"
required: true
responses:
"200":
description: "user information"
x-apigateway-request-type: "public"
x-apigateway-cors: true
x-apigateway-match-mode: "NORMAL"
x-apigateway-backend:
type: "HTTP"
parameters:
- name: "userld"
value: "userld"
in: "query"
origin: "REQUEST"
description: "user id"
- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "invoke user"
httpEndpoints:
address: "example.com"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000

securityDefinitions:
apig-auth-app:

in: header

name: Authorization

type: apiKey
x-apigateway-auth-type: AppSigv1

apig-auth-iam:

in: header

name: unused

type: apiKey
x-apigateway-auth-type: IAM

Importing an HTTP VPC Backend Service API

swagger: "2.0"

info:
title: "importHttpVpcEndpoint"
description: "import apis"
version: "1.0"

host: "api.account.com"

Import the request parameter definition of an HTTP VPC backend service API that
uses the ANY method and is accessed through App authentication.
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paths:
'/http-vpc"
x-apigateway-any-method:
operationld: "userOperation"
description: "user operation resource"
security:

- apig-auth-app: []

schemes:

- https

parameters:

- name: "Authorization"
description: "authorization signature"
type: "string"
in: "header"
required: true

responses:

"default™:
description: "endpoint response"
x-apigateway-request-type: "public"
x-apigateway-cors: true
x-apigateway-match-mode: "SWA"
x-apigateway-backend:
type: "HTTP-VPC"
parameters:
- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "invoke user"
httpVpcEndpoints:
name: "userVpc"
scheme: "http"
method: "GET"
path: "/users"
timeout: 30000
securityDefinitions:
apig-auth-app:
in: header
name: Authorization
type: apiKey
x-apigateway-auth-type: AppSigv1
apig-auth-iam:
in: header
name: unused
type: apiKey
x-apigateway-auth-type: IAM

Importing a Function Backend Service API

Import the request parameter definition of a FunctionGraph backend service API
that uses the GET method and is accessed through IAM authentication.

swagger: "2.0"
info:
title: "importFunctionEndpoint"
description: "import apis"
version: "1.0"
host: "api.account.com"
paths:
'/function/{name}"
get:
operationld: "invokeFunction"
description: "invoke function by name"
security:
- apig-auth-iam: []
schemes:
- https
parameters:
- name: "test"
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description: "authorization token"
type: "string"

in: "header"

required: true

- name: "name"

description: "function name"
type: "string"

in: "path"

required: true

responses:

"200":
description: "function result"

x-apigateway-request-type: "public"
x-apigateway-cors: true
x-apigateway-match-mode: "NORMAL"
x-apigateway-backend:

secu
api

type: "FUNCTION"
parameters:
- name: "functionName"
value: "name"
in: "query"
origin: "REQUEST"
description: "funtion name"
- name: "X-Invoke-User"
value: "apigateway"
in: "header"
origin: "CONSTANT"
description: "invoke user"
functionEndpoints:

function-urn: "your function urn address"

version: "your function version"
invocation-type: "async"
timeout: 30000

rityDefinitions:

g-auth-app:

in: header

name: Authorization

type: apiKey
x-apigateway-auth-type: AppSigv1

api

g-auth-iam:

in: header

name: unused

type: apiKey
x-apigateway-auth-type: IAM

Importing a Mock Backend Service API
Import the definition of a Mock backend service API that uses the GET method

and is accessed without authentication.

swagger: "2.0"

info:
titl

e: "importMockEndpoint"

description: "import apis"
version: "1.0"
host: "api.account.com"
paths:
'/mock":
get:

operationld: "mock"
description: "mock test"
schemes:
- http
responses:

"200":

description: "mock result"

x-apigateway-request-type: "private"
x-apigateway-cors: true
x-apigateway-match-mode: "NORMAL"
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x-apigateway-backend:
type: "MOCK"
mockEndpoints:
result-content: "{\"message\": \"mocked\"}"
securityDefinitions:
apig-auth-app:
in: header
name: Authorization
type: apiKey
x-apigateway-auth-type: AppSigv1
apig-auth-iam:
in: header
name: unused
type: apiKey
x-apigateway-auth-type: IAM
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